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1.  Introduction

This user guide describes how to use DataMerge, a
powerful PC-based document assembly and data
merging tool that allows you to merge variable data
onto Elixir format forms and then output the document
to Xerox production printers, PostScript and HP La-
serJet Series II or compatible PCL 4 printers.

DataMerge overview

The following section provides an overview of the
steps required to merge variable data onto an Elixir
form, or series of Elixir forms, using DataMerge.

1. Create a form

DataMerge merges variable data with Elixir format
(.ELX) forms.  You can create Elixir format forms us-
ing any Elixir form creation package such as "Elixir
Forms Editor," "ElixirForm for AFP" or "ElixiForm."
These packages enable you to work with documents
in a WYSIWYG environment and to fully define the
DataMerge data fields when you create forms.  

You can also create a form in a supported Windows
application and convert it to .ELX format using the
Elixir PrintDriver.  See the Elixir PrintDriver User
Guide for more information.

The default directory for Elixir format forms is
drive:\ELIXIR\FORMS\ELIXIR\.

Depending on the Elixir forms package you have in-
stalled, your screens and options may differ slightly
from the figures displayed in this guide.
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See the appropriate user guide for information on cre-
ating a form.

2. Tag a form

Data fields must be defined and added to your form to
indicate where specific variable data will be placed.
For example, a field may define where a name ap-
pears on the form.  Graphics calls define where a
graphic is placed on a form.  Adding data fields and
graphics calls to a form is called tagging a form.

You can tag a form using the data tagging dialog box
or by referencing data fields in an external tag attrib-
ute file.  See the "Adding tags" chapter for more
information.

3. Create a variable data file

A variable data file is an ASCII file with a .DAT exten-
sion that contains printer commands, the name of the
form(s), variable data, and graphics calls.  An exam-
ple of variable data for the name field defined above is
"Charles Edwards."  This data displays in the name
field when you view or print the form.  After you create
a data file, you can preview the form merged with the
variable data using ElixirViewer.

See the "Data files" chapter for more information.

4. Merge a form with variable data

You can merge the form with the variable data and
print to the printer or to disk.

To output to HP PCL or Postscript format from
the Elixir Desktop, drag a .DAT file to the Printers
icon or to the Converter icon.  See the "Da-
taMerge operation for Windows" chapter

To output to HP PCL, Postscript or Xerox format
from the DataMerge interface, set up options and
run DataMerge from the pull-down menus in the
Main DataMerge dialog box.  See the "DataMerge
operation for DOS" chapter for more information.

INTRODUCTION
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DataMerge sample application

Your DataMerge software includes a sample applica-
tion.  This application includes an Elixir format form
called RAFFLE.ELX which is tagged as described in
the "Adding tags" chapter, and three data files called
RAFFLE1.DAT, RAFFLE2.DAT and RAFFLE3.DAT,
each created using a different .DAT file format as de-
scribed in the "Data Files" chapter.

If you want to view these sample files, make sure you
select the [Application] option from the Files To Install
window during installation. 

Customer support

If you have purchased your Elixir product directly from
Elixir Technologies then contact the support center for
your region at the number listed below.

North and South America: 
+1  805 641 5900 ext. 3

Asia Pacific 
+92 (0) 51 206182

Europe  
+420 2 2431 13877

The U.S.A. Elixir Customer Support Center provides
telephone technical assistance for Elixir users Monday
through Friday from 6:30 a.m. to 5:00 p.m.  Pacific
Standard Time.

If you have any problems running or using Elixir Print-
Driver or associated Elixir applications, contact the
support center in your region for help.  An Elixir prod-
uct specialist will answer your call and ask for the fol-
lowing information:

INTRODUCTION
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your name, organization, telephone number and
address.

the name and version number of the Elixir
application.

a complete description of the problem, including
any error messages displayed on your monitor or
printed at your printer.

You can contact Elixir support  by accessing the
Elixir World Wide Web page (and selecting [Con-
tact Support]) at http://www.elixir.com.  Please
complete the question form.

Elixir Web site support

The Elixir Web site at http://www.elixir.com offers the
following resources:

Raise a question for Elixir Support.

Find answers in the list of Frequently Asked
Questions.

Review the latest Tips and Techniques for in-
creasing productivity using Elixir software.

Download new releases and the latest patches.

View Release Notes for the latest available
features.

Learn in the user newsgroup how others are us-
ing Elixir products.

Sign up for an Elixir Learning Program.

INTRODUCTION
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Elixir training

Elixir Technologies Corporation offers training for the
full range of Windows-based products.  For more in-
formation, contact:

Hardware  and software requirements

The following sections describe the hardware and
software requirements for running DataMerge.

Hardware

Recommended PC configuration: Pentium (or
100% compatible), with at least 133 MHz processor
(or the fastest commercially available processor); 32
MB RAM, 500+ MB hard drive, one CD-ROM drive.

Additional requirements:  

any monitor with driver software supporting Win-
dows in VGA or SVGA 

any Windows-compatible mouse.

Optional requirements

One of the following for communicating with
Xerox printers:

any PC-to-mainframe or communications
board that supports binary file transfers (such
as IBM PC3270, IRMA FT/3270, or AS/400
PC communications packages)

any 9-track, 1600 or 6250 bpi tape drive
(such as the Qualstar with the Overland TX-8
controller card).

    Elixir Learning
(805) 641-5900  ext. 6

INTRODUCTION
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One or more of the following peripheral devices:

Xerox production printer

HP LaserJet IV or compatible PCL 4 printer
(HP PCL 4 is the format supported), or Post-
Script compatible

CD-ROM Player

Tape drive configuration

If you use a Qualstar tape unit, copy the
TAPE_MT0.SYS file (and, if provided, the
LDIMG.EXE file) from the driver diskette supplied by
Qualstar to your root directory.  

Add the following line to your CONFIG.SYS file:

DEVICE= TAPE_MT0.SYS 8

If LDIMG.EXE is included on the Qualstar driver
diskette, add the following command to your
AUTOEXEC.BAT file:

LDIMG 

Software

Software requirements: Microsoft Windows 95, Win-
dows 98, or Windows NT 4.0 or later. 

While we make every effort to ensure the proper op-
eration of our software, some problems cannot be re-
solved due to differences in the operating systems.

Who should use this guide

This user guide is intended for users familiar with Win-
dows.  You should be familiar with your PC peripher-
als and have access to reference manuals for your PC
software and hardware, and your printer.

INTRODUCTION
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Conventions

Most of the following conventions are the same or
similar to Windows conventions.

display conventions

typographical conventions

mouse operations

Display conventions

The Elixir Desktop, ElixirForm, ElixirFont and Elix-
irImage all adhere to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons and mouse.  See your Win-
dows manual for more information.

Typographical conventions

The following typographical conventions are used
throughout this guide and other Elixir product guides.

Keystrokes are shown enclosed in < > (angle
brackets). For example:  

<Enter>

Key combinations are denoted by a plus sign be-
tween keys. For example: 

<Shift> + <F1> indicates to simultaneously press
the <Shift> and the <F1> keys.

Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example:

Select [New] from the File menu.

INTRODUCTION
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Commands, options, actions, and parameters
that require description are shown in bold fol-
lowed on the next line by the description.  For ex-
ample:

Delete
Deletes the selected files.

Steps in a procedure are shown in numbered bold
paragraphs.  For example:

1. At the prompt, enter the file name and
extension.

Comments relating to a step (such as this para-
graph) are shown in regular text following the bold
paragraph.

Commands you enter at the DOS prompt are
shown in larger text.  Within DOS commands,
variable names and keys you press are shown in
italics.  For example: 

CD \ELIXIR <Enter> 

Mouse operations

You can perform most operations in Elixir applications
by using the mouse.  The terminology is similar to
other Windows based applications.

Mouse operations are performed using the left or right
mouse buttons, depending on the specific task.

The following mouse related terms are used in this
guide:

click
to momentarily press and release the left mouse but-
ton once.  A right mouse button click is specified
where necessary.  For example,

Click on the right mouse button to finish entering text.

double-click
to click the left mouse button twice in rapid
succession.
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drag
to click and hold the mouse on an item and move the
item with the mouse.

drag and drop
to drag an item as above, then release the mouse but-
ton, once the item is positioned over a the area.  If the
selected object is a file and the destination is a direc-
tory, the file copies to the directory.

object
a selectable item on the screen.

open
to point and double-click on an icon -- the effect of this
operation depends on the icon.

point
to move the mouse to position the screen pointer on
an area of the screen.

select
to point to an object and click the mouse -- this usually
highlights the object.

<Alt>click
to hold down the <Alt> key while pressing the left
mouse button -- this allows you to select a range of
files in a window.

<Ctrl>click
to hold down the <Ctrl> key while pressing the left
mouse button -- this allows you to select individual
files from a group in a window.

<Shift>click
to hold down the <Shift> key while clicking the mouse
-- this allows you to select more than one object at a
time. 

INTRODUCTION
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On-line Help

Elixir software uses the Microsoft Windows Help pro-
gram to provide on-line Help for all functions.

For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.

The Help files included with your Elixir software in-
clude graphics created using screen drivers with large
fonts.  If you use a screen driver with small fonts, the
Help file graphics may not display clearly.  For opti-
mum graphics display, use a screen driver with large
fonts.

You can display on-line Help in the following ways:

Bubble Help
Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.  

Quick Help
Enable the quick function by selecting the quick help
option in the Usage Switches (or Preferences -- for
ElixirImage) dialog box.  When you move the screen
pointer over an icon on the screen, a short description
of the icon function displays in the message area of
the screen.  During certain operations a message
about the function you are performing also displays in
the message area.  To see these operational mes-
sages, disable quick help.

Context sensitive Help
To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays.  If no
specific topic is available, the Help table of contents
displays.

Help menu
Select [Help] from the top pull-down menu and choose
one of the displayed topics.

INTRODUCTION
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Dialog box Help
Click on the [Help] button in a dialog box to view an
associated Help topic.  Under Windows 95 and Win-
dows NT, right-click on a dialog box option to display
an associated Help topic.

Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps.  When you click on a
pop-up topic, a box displays within the current Help
topic with additional information.  When you click on a
jump, a different, associated Help topic displays.

Help hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots".  Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions).  

Move the cursor over a hypergraphic until a hand dis-
plays, then click on this hot spot to display a pop-up
topic, or a "jump".  To close a pop-up topic, click the
mouse button.  To return to the original Help topic
from a jump, click on <Back> in the Help file menu. 

Using Online documentation

This section describes how to use PDF online docu-
mentation, including navigating through the online
guides and printing the guides.  Acrobat Reader is
provided with the online documentation.  Information
about using the Acrobat Exchange program is in-
cluded for users who have licenses for that program.

INTRODUCTION
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Accessing online guides

The PDF online documentation is copied to the
drive:\Elixir\help\pdf directory during the installation.  If
you didn't choose to copy the PDF online documenta-
tion during the installation, you can view a complete
list of the files by clicking on the Windows [Start] but-
ton and selecting Programs>Elixir Applications>Elixir
PrintDriver for AFP.  Once the application is launched,
click on the Help menu and select Release Notes.
Wordpad displays a current list of supporting docu-
ments and the directories where they can be found on
CD-ROM.

When the appropriate PDF file is accessed the Acro-
bat Reader program is launched and the List of Online
Guides is displayed.  Click on a guide to view its table
of contents and jump to individual chapters. 

The following list of PDF files and associated docu-
ment names are installed in the drive:\Elixir\help\pdf
directory.

StartAFP.pdf - AFP Getting Started Guide

StartXRX.pdf - Getting Started User Guide

DeskAFP.pdf - Elixir Desktop and Converters for
AFP User Guide

DeskXRX.pdf - ElixiSys Desktop User Guide

FormAFP.pdf - ElixirForm User Guide

FormXRX.pdf - ElixiForm User Guide

FontAFP.pdf - ElixirFont User Guide

FontXRX.pdf - ElixiFont User Guide

ImageAFP.pdf - ElixirImage User Guide

GraphXRX.pdf - ElixiGraphics User Guide

PdAFP.pdf - Elixir PrintDriver for AFP User Guide

PDXRX.pdf - Elixir PrintDriver User Guide

PdNT.pdf - Elixir PrintDriver for NT User Guide
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PHXRX.pdf - PageHandler User Guide

DTAG.pdf - DocuTag User Guide

DMerge.pdf - DataMerge User Guide

AppVIPP.pdf - Elixir AppBuilder for VIPP User
Guide

AppAFP.pdf - Elixir AppBuilder for AFP User
Guide

Transfmr.pdf - Elixir Transformer Suite User
Guide

Viewer.pdf - ElixirViewer User Guide

Elxscan.pdf - ElixiScan User Guide

Navigating in online guides

After loading a PDF document in Acrobat Reader or
Exchange program (as described above), you can
navigate through the online guide by clicking on the
following:  

TOC chapter titles - jumps to the beginning of the
chapter indicated.

[Next Page] or [Previous Page] in the Toolbar - jumps
to the next or previous page of the online guide (alter-
natively, you can use the <Page Up> and <Page
Down> keys).

[Go Back] in the Toolbar - returns to your previous
location.

[First Page] in the Toolbar - returns to the opening
screen of the online guide.

INTRODUCTION
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Word find

This option finds a key word or phrase in the current
document.

To use Word Find in a document:

1. Click on the [Find] icon in the Toolbar.

2. Enter the desired search text and click on
[Find].

The Acrobat Find dialog box closes and the first
occurrence of the text is highlighted.

3. To find more occurrences of the same text,
click on the [Find] icon in the Toolbar and
then click on [Find Again] in the Find dialog
box.

Page scrolling

You can move a document on the screen to view por-
tions of it not visible in the window, or read a docu-
ment which contains article threads by clicking the
mouse to scroll through the document without using
the scroll bar.

To move a document on the screen for viewing (func-
tional only when the document displays wider than the
document window):

1. Click on the [Hand] icon in the Toolbar.

2. Hold down the mouse button and drag the
cursor in the desired direction.

To follow the flow of text in a document that contains
article threads (automatic text flows):

1. Click on the [Hand] icon in the Toolbar.

2. If the document contains article threads, a
“down” arrow displays on the Hand icon.

3. Position the hand-shaped cursor over a
paragraph and click on the paragraph to begin
reading. 
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4. Continue clicking to follow the flow of text.

Zoom in/out

To magnify the size of the page display, click on the
Zoom icon in the Toolbar, then click in the Work area.
Each click resizes the view by a factor of two.

To reduce the size of the page display, click on the
Zoom icon in the Toolbar, then hold down the <Ctrl>
key and click in the Work area. 

You can also click on the [%] button at the bottom of
the screen and select a zoom percentage from the
pop-up list.

Printing online guides

You can print individual chapters or an entire book to
PostScript or HP printers:

1. Open the file.

2. Select File>Print.

The Print dialog box displays.

3. Select your printing options and click on [OK].

Organization of this guide

This user guide contains the following chapters:

Chapter 1, "Introduction," provides an introduction to
DataMerge and describes the contents of this user
guide.

Chapter 2, "Adding tags," describes how to define and
add data fields and graphics calls to a form.

Chapter 3, "Data files," describes how to create data
files and job files, and how to preview a merged form
using ElixirViewer.

INTRODUCTION
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Chapter 4, "DataMerge operation for Windows," de-
scribes how to operate DataMerge from the Elixir
Desktop for merging and printing variable data with a
form for output to a PostScript or HP LaserJet Series
II or compatible PCL 4 printer.

Chapter 5, "DataMerge operation for DOS," describes
how to operate DataMerge from the DataMerge inter-
face for merging and printing variable data with a form
for output to a PostScript printer, HP LaserJet Series
II or compatible PCL 4 printer or a Xerox production
printer.

Chapter 6, "Moving and printing files," describes how
to upload files from your PC to a host environment for
processing and subsequent delivery to the printer.

Chapter 7, "Stand-alone utilities," describes how to
use the stand-alone utilities provided with DataMerge.

Appendix A, "DataMerge error messages," lists the er-
ror messages issued by DataMerge.

Appendix B, "External tag attribute files," provides in-
formation for users who need more detailed informa-
tion about the external tag attribute file such as
application developers and programmers.

Appendix C, "Command line parameters" lists the op-
tional parameters for running DataMerge in batch
mode.

Before installation

If you plan to use DataMerge with any other Elixir
products, make sure you know the drive on which
they are installed.  This is the drive where you
must install the Datamerge program.

Complete the software licensing process (See the
"Product Registration" section).

To avoid any possible conflicts, exit all other ap-
plications before installation.
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1-16 ELIXIR TECHNOLOGIES CORPORATION



You may want to make a backup copy of your
diskettes prior to installation.  

Release notes

Release notes appear at the beginning of the Elixir
software install process, so that you can review each
entry before performing the complete installation.
Once the software is installed, release notes can be
accessed from the Help menu of the application.  Re-
lease notes are formatted for viewing in Notepad or
Wordpad.  They have a txt file extension and are
found in the drive:\ELIXIR \RELNOTES directory.

Product Registration

Elixir products no longer require ElixiKey hardware de-
vices attached to your parallel port.  Elixir products
now utilize soft key technology.  This new licensing
process validates your license agreement with Elixir
and places a file (password.epw if an Elixir customer,
or License.dat if a Xerox customer) on your
workstation.

Version 4.00 implements Elixir's new licensing proc-
ess and discontinues use of the current hard keys.  All
customers must register/re-register software licen-
se(s) by using the Elixir registration program provided
with the software. 

Each product installed is assigned to a specific pc.
This pc number, your customer number, and pass-
word are required.  This information is provided when
you purchase Elixir software or when you upgrade to
version 4.00 of Elixir products.

If you are an Elixir customer, registration can be com-
pleted automatically if you have an internet connection
on your workstation.  If you are a Xerox customer you
must contact Xerox to register your products.
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This section describes the registration process for
those customers who have purchased their Elixir
products form Elixir Technologies.

The following scenarios describe the  registration
process for Elixir  customers.  Xerox Corporation will
provide a separate document that describes  register-
ing your products with Xerox.

you are a new customer and will use Soft Key
registration

you are an existing customer and will change to
Soft Key registration 

Elixir Product Registration screen

Make your selections according to your needs and go
to the appropriate section for further procedures.

Figure 2-1.  Elixir Product Registration screen
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Using the internet 

You can register and download all registration files via
the Elixir Product Registration program.  There are
two ways to register your products using  the Internet:

down load the product registration file directly to
the Elixir PC via the Internet (see "Registering as
a new customer via the internet")

download the product registration file to another
machine and move it to the Elixir PC (see "Down-
loading via the internet to a non-Elixir PC")

Registering as a new customer via the internet 

You will receive a "Customer Activation Letter" with
your product(s) ordered.  The registration process
should be completed before installing your software.
The installation CD will launch and install the Registra-
tion Program. 

To install the registration program on your Elixir PC: 

1. In the Software Registration screen, click on
[Next].

2. Select the drive and click on [Next].

3. In the Start Registration Process screen, click
on [Install].

The password file will be installed and your sys-
tem configured.

To complete registration:

1. In the Elixir Product Registration "Welcome"
screen, select [Next].

Your machine serial number displays.

2. Enter your customer number (from Activation
Letter), then click on [Next].

INTRODUCTION
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3. Enter your password and the PC number you
want to register, then click on [Next]. 

4. Select [Prepare and download my initial
product license registration.  This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next]. 

5. In the Download Password screen, click on
[Yes].  

The system displays your customer information
and you must verify that it is correct.

6. When the screen displays the registration
information, click on [Save].  You may also
print this screen for reference or to send to
Elixir.

The application installation process will begin, see the
"Installation" section.

Downloading via the internet to a non-Elixir PC  

You will receive a "Customer Activation Letter" with
your product(s) ordered.  The registration process
should be completed before installing your software.
The installation CD will launch and install the Registra-
tion Program. 

To install the registration program on your Elixir PC: 

1. In the Software Registration screen, click on
[Next].

2. Select the drive and click on [Next].

3. In the Start Registration Process screen, click
on [Install].

The password file will be installed and your sys-
tem configured.

To complete registration:

1. In the Elixir Product Registration "Welcome"
screen, select [Next].

INTRODUCTION

1-20 ELIXIR TECHNOLOGIES CORPORATION



Your machine serial number displays.

2. Enter your customer number (from Activation
Letter), then click on [Next].

3. Enter your password and the PC number you
want to register, then click on [Next]. 

4. Select [Prepare and download my initial
product license registration.  This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next]. 

5. In the Download Password screen, click on
[No].  

6. In the How to Contact Elixir screen, click on
[Print] and take the printout to the pc
connected to the internet.

7. Access the Elixir Web site at
http:\\www.elixir.com. and click on [Product
Registration].

8. In the Customer Information screen, enter
your Customer Number and Password, then
click on [Submit Form].

9. In the Elixir Customer Menu, click on
[Download a New License File].

10. In the Customer Information screen, enter
your PC Number and Machine Serial Number,
then click on [Submit Form].

11. In the Elixir Technologies screen, click on
[Click here to download your password].

12. Save the password.epw file to diskette and
copy it to your Elixir PC in the \ELIXIR
directory. 

The application installation process will begin, see the
"Installation" section.
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Contacting Elixir (no internet connection) 

If you have no internet access at your site you must
contact Elixir and provide the serial number of the pc
where you will install the Elixir software.  Elixir will pro-
vide a registration file (password.epw) that you must
copy to the Elixir pc.

Copy the password.epw file to \Elixir and start the
installation.  

Select [Prepare my initial product license registration.
This workstation is not connected to the Internet] from
the Registration Option menu, then click on [Next].

The application installation process will begin, see the
"Installation" section.

Soft key customers running Windows for Workgroups 3.1 or 3.11 

Since Windows 3.1/3.11 does not have internet capa-
bility, you must contact Elixir to obtain your password
file.   After installation of Elixir software, the installation
program verifies that the operating system is 3.1 or
3.11, runs passwd16.exe, and provides your machine
serial number. 

To complete registration: 

1. Enter your customer number, password and
PC number, then print out a copy of this
screen. 

2. Fax, email, or mail Elixir the display printout.
Elixir will generate a password.epw file and
send it to you on diskette. 

3. Load the password.epw file in the \ELIXIR
directory. 

The application installation process will begin, see the
"Installation" section.
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Installation

This section describes how to install Elixir software
using the [Full] and [Custom] options. Installing addi-
tional Elixir applications to an existing version is also
explained.

Note: The software registration process must be com-
pleted (See the "Product Registration" section).

For information about starting Elixir applications after
installation, refer to the "Introduction" chapter. 

During installation, the log file,  XWIN.log, is created in
the drive:\Elixir directory.  XWIN.log contains a list of
all directories and files copied or created, including in-
formation pertinent to the installation.  It can be ac-
cessed, using Notepad or Wordpad. 

If you have any problems running Elixir software after
installation, refer to Appendix A, "Operational and er-
ror messages", or the "Troubleshooting" section of the
Elixir Getting Started Guide for more information.

Installing Elixir applications

Elixir provides a simple, interactive procedure for in-
stalling Elixir applications.  

During installation you can select [Full] or [Custom]
installation.

Selecting a [Full] installs all Elixir applications and
demonstration files on the same drive.  If you
have a previous version of Elixir software, this op-
tion overwrites the existing version.

Selecting a [Custom] installation allows you to
choose the Elixir applications and options (such
as Elixir demonstration files) you want installed,
as well as where you want certain options in-
stalled.  For example, You may want the PDF
documentation in a different directory than the ap-
plication.
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You can also install Elixir program files (required
to run Elixir), and data files (files that you create
or files such as the Elixir demonstration files), in
separate drives and directories.

Full installation

To begin installation:

You can quit installation at any time, by pressing the
<Esc> key. 

1. Close all active applications.

2. Insert the CD in your CD-ROM drive.

3. In the "Welcome" screen, click on [Next].

The Release Notes? screen displays.

4. Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.

The Product Selection screen displays.

5. Select the applications you want to install and
click on [Next].

The Selected Products screen displays.

6. Verify the listed applications and click on
[Next].  If you need to delete or add to the list,
click on [Back] and reselect.

7. Verify your user information and click on
[Next].

8. In the Select Install Type screen, select [Full]
and click on [Next].

9. Select the drive on which you want Elixir
software installed, then click on [Next]. 

10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next]. 
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11. In the Backup Replaced Files screen,  click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].

12. In the Start Copying Files screen, click on
[Install].

Installation begins.

13. Once installation is complete, click on [Exit
Installer].

Custom installation

To begin installation:

You can quit installation at any time, by pressing the
<Esc> key. 

1. Close all active applications.

2. Insert the CD in your CD-ROM drive.

3. In the "Welcome" screen, click on [Next].

The Release Notes? screen displays.

4. Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.

The Product Selection screen displays.

5. Select the applications you want to install and
click on [Next].

The Selected Products screen displays.

6. Verify the listed applications and click on
[Next].  If you need to delete or add to the list,
click on [Back] and reselect.

7. Verify your user information and click on
[Next].
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8. In the Select Install Type screen, select
[Custom] and click on [Next].

9. In the Configuration Only? screen:

Selecting [Yes] allows you to load Configura-
tion, Program, and Data files into  any resi-
dent directory.

Selecting [No] allows you to deselect options
you do not wish installed.

10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next]. 

11. In the Backup Replaced Files screen,  click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].

12. In the Start Copying Files screen, click on
[Install].

Installation begins.

13. Once installation is complete, click on [Exit
Installer].

Adding applications

If you did not install all of the Elixir options while per-
forming the Custom installation procedure, you can do
so at any time by following the steps described in the
"Custom installation" section of this chapter.

Adding newly licensed applications

If you purchase additional Elixir products,  Elixir will
update your password file.  You can access the Prod-
uct Registration program from your program group
and re-download your initial product registration pass-
word file to activate your new products.
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2.   Adding tags

This chapter describes how to add data fields and
graphics calls to Elixir format (.ELX) forms and
Windows-based documents for merging with variable
data ready for printing on Xerox production printers,
HP LaserJet Series II or compatible PCL 4 printers, or
PostScript printers.

The following sections provide an overview and de-
scribe how to create an external tag attribute file, two
methods for tagging an Elixir form and two methods
for tagging a Windows-based document. 

Overview

Data fields define the location and attributes of the
variable data to be merged with the form.  For exam-
ple, a data field may define where an address displays
on a form.  Graphics calls define where graphics are
placed on the form.

Adding DataMerge data fields to new or existing forms
or documents is called tagging a form.  You can tag
an Elixir form or Windows-based document by creat-
ing an external tag attribute file and referencing fields
within that file in your document.  You can also tag an
Elixir form using the Data Tagging dialog box in your
Elixir Form application.   

If you plan to use the same tag file for different forms
or documents, you should use the method of creating
an external tag attribute file and referencing the fields
in your document.
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Viewing the sample form

If you selected to install the sample application during
installation, you can view the sample tagged form,
RAFFLE.ELX in your Elixir Forms package in the fol-
lowing directory.

drive:\ELIXIR\FORMS\ELIXIR\DEMO

drive
the drive where you installed DataMerge.

Note that replacement characters display where the
tags are placed.  To view a tag, select the Select/Edit
icon in the Toolbox and right-click on a tag.  The Data-
Tagging dialog box displays settings for the tag.   

If you did not install the sample application and you
want to view the form, reinstall DataMerge and make
sure you select the [Application] option in the Files To
Install window during installation.

External tag attribute files 

You can create, view or edit an external tag attribute
file using the ElixiTag utility provided with your Da-
taMerge software.

An external tag attribute file contains parameters for
data fields, such as the field name, length and re-
placement character.  You can reference these fields
in your Elixir form or, if you are a PrintDriver user, in
your Windows-based document.  

If you want to use the same tags in multiple forms or
embed tags within text blocks, you should create an
external tag attribute file.        

The following section describes how to use the Elixi-
Tag utility supplied with DataMerge to create, save,
edit and delete an external tag attribute file. If you
need more detailed information about external tag at-
tribute files, see the "External tag attribute file"
appendix. 
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Creating an external tag attribute file 

You can create an external tag attribute file using the
ElixiTag utility supplied with DataMerge. 

To activate ElixiTag and create an external tag attrib-
ute file:

1. From the Windows Program Manager,
double-click on the ElixiTag icon. 

 The ElixiTag dialog box displays.

Figure 2-1.  ElixiTag dialog box

2. Pull down the File menu and select [Open].

The Open dialog box displays.
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Figure 2-2.  Open dialog box

3. Select the directory and enter a new file name
with a .TAG extension.  

The default directory is drive:\ELIXIR.

Note that if you are using ElixiTag with PrintDriver
to tag a Windows-based document, make sure
you use the default tags directory.  

4. Click on [OK].

The ElixiTag dialog box displays the specified file
name in the header.

5. Enter parameters for the first data field.

You can change a current parameter by back-
spacing over the current parameter and entering
a new one. 

Search by Name
This field allows you to enter a field name that exists
in the current tag list and apply the same parameters
to the current field.  

To use this option, enter the name of the field.  If Da-
taMerge finds a match in the current tag list, the pa-
rameters of that field display.

Number
Enter the number of the field.  As you add tags, field
numbers (up to 750) are automatically updated.       
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Name
Enter the name of the variable data field (maximum
31 characters).  If you use the space bar to separate
words, DataMerge automatically inserts an under-
score ( _ ) in that space.

Length
Enter the maximum number of characters allowable in
the specified field.  Note that if the variable data item
requires less than the maximum number of charac-
ters, the paragraph will be formatted so that there are
no extra spaces between the variable data item and
any following text. 

Make sure any non-replacement characters are also
included in the field length.  For example, if you want
the date to display in the field as follows: **/**/**
(where * is the specified replacement character), you
must enter the number 8 in this window.

Replacement Char(acter)
Variable data fields are denoted in your document as
a string of replacement characters.  Replacement
characters are usually @, !, #, or " characters.  These
are the characters that rotate automatically when you
add a new field.  

If you want to specify your own replacement charac-
ter, backspace over the default character and enter a
new one. 

Mandatory 
This option is reserved for future use.

Delete After Use
Specify [Y] if you use the same field name in multiple
forms, but require different values for each use.  

Specify [N] if you use the same field name in multiple
forms with the same data value for each use.

The default is [N].

If you specify [Y] for this option, select the [Use Data
Field Name] option when running DataMerge in Win-
dows or the [-USENAME] parameter when running
DataMerge from the Dispatcher or from the DOS
command line.  See the applicable "DataMerge opera-
tion" chapter. 
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Field End
This option is reserved for future use.

Multi-Data
This option is reserved for future use.

Align
This option is reserved for future use.

Depth
This option is reserved for future use.

Field Gen
Enter the non-replacement characters as you want
them to appear in relation to the replacement charac-
ters.  Maximum field length is 31 characters.

For example, to separate the month, day, and year in
the date field with slashes, you would type **/**/**
(where * is the replacement character you specified).
To print the telephone number, you may want to type
(***)***-**** (where * is the replacement character you
specified).

Comment 
Enter a comment (maximum 31 characters) about the
field. 

6. Click on [Add New Tag].

ElixiTag updates the field number and the re-
placement character and then resets the other
parameters to the defaults. 

7. Enter attributes for the next tag.

Continue to add tags to the external tag attribute
file.  The maximum number of tags per document
is 750.

You can scroll through the current tag list by clicking
on the left or right arrow in the [Scroll by Number] op-
tion.  If the tag list contains many fields, press and
drag the scroll box forward or backwards. 
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Saving an external tag attribute file

You can save an external tag attribute file with the
same name or with a different name. 

To save an external tag attribute file with the same
name:

1. Pull down the File menu.

2. Select [Save].

The external tag attribute file is saved with the
same name.

To save an external tag attribute file with a different
name:

1. Pull down the File menu.

2. Select [Save As]

The  Save As dialog box displays.

           Figure 2-3.  Save As dialog box

3. Enter a new file name and specify a directory
for the file.

4. Click on [OK]

The external tag attribute file is saved with a new
name.

The default directory for external tag attribute files is
drive:\ELIXIR.
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Editing a tag

You can use ElixiTag to edit any tags in your tag file.

To edit a tag:

1. Pull down the ElixiTag File menu and select
[Open].

The Open dialog box displays.  (See Figure 2-2.)

2. Select the file you want to edit and click on
[OK].

3. Use the [Scroll by Number] option to display
the data field you want to edit.

4. Edit an option by backspacing over the
current parameter and entering a new
parameter.

5. Repeat the procedure for each data field you
want to edit.

6. Pull down the File menu and select [Save] to
save your edits in the current file, or select
[Save as] to save the file with a new name.

Deleting a tag

You can use ElixiTag to delete any tags in your tag
file.

To delete a tag:

1.  Pull down the File menu and select [Open].

The Open dialog box displays.  (See Figure 2-2.)

2. Select the external tag attribute file and click
on [OK].

3. Use the [Scroll by Number] option to display
the data field you want to delete.

4. Click on [Delete].

The tag is deleted from the tag file.
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Tagging Elixir forms

You can add tags to an Elixir form by referencing a
data field in an external tag attribute file or by using
the Data Tagging dialog box included with your Elixir
Form application.  If you want to use the same tag file
for different documents or if you want to embed tags
within a text block, you should use the method of data
field referencing as described below.

Note that if you have tags embedded in paragraphs
and are printing metacode, you must use the
FORMCVT utility to convert the .ELX file to .FRM and
specify the $$CALLFORMS command in the .DAT file.
For information about the FORMCVT utility, see the
"Stand alone utilities" chapter.  For information about
the $$CALLFORMS command, see the "Data files"
chapter.

After you have added a tag to your form, you can only
change the field number of tags that reference data
fields.  If you are using the Data Tagging dialog box to
add tags to your form, you may want to complete your
form before adding tags. 

Data field references 

To use this method for tagging a form, you must cre-
ate an external tag attribute file.  You can use the Elix-
iTag utility provided with DataMerge to create an
external tag attribute file.  See the "External tag attrib-
ute file" section in this chapter for information on how
to create and save an external tag attribute file. 

To reference a data field in an external tag attribute
file:

1. Load an existing or new form into your Elixir
Form application. 

2. Select the Text tool.

The Text toolbox displays.
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Figure 2-4.  Text toolbox

3. Select a font.

4. Place the cursor on the form where you want
the variable data to print.

5. Enter the following, depending on the format
of your .DAT file.  (See the "Data files" chapter
for information about the format of .DAT files.)
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If your .DAT file follows format 2 or 3, you can
enter

%%n;

n
is the number of the data field you are refer-
encing, for example.

For example,  %%1;

If your .DAT file follows format 1, 2 or 3, you
can enter

%%n fieldname;

n
is the number of the data field you are refer-
encing.

fieldname
is the name of the data field you are referenc-
ing

For example, %%2 ADDRESS;

Note that there is a space between the num-
ber and the fieldname.

DataMerge only uses field names if using for-
mat 1 in the .DAT file and if specified when
merging.  See the "Format 1" section in the
"Data files" chapter for more information.

6. Continue to enter text and add fields as
required.

Specify the external tag attribute file when you merge
and print the form.

Using Data Tags

Your Elixir Form application includes a Data Tagging
dialog box for adding tags between text blocks in your
Elixir (.ELX) form.  The following section describes
how to use the Data Tagging dialog box to tag an
Elixir form.  
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If you want to embed a tag within a text block or if you
want to tag different documents with the same tag file,
you should use the method of creating an external tag
attribute file and referencing the data fields in that file
as described previously in this chapter.  See the "Data
field references" section in this chapter for more infor-
mation.   

To use the Data Tagging dialog box to add a tag to an
Elixir form:

1. Load a new or existing form into your Elixir
Form application.

2. Select the [Data Tags] option in the Text
toolbox.

3. Set the font and text properties for the
variable data from the Text toolbox.

4. Click on the form in the location where you
want to add a tag. 

The Data Tagging dialog box displays.

              Figure 2-5.  Data Tagging dialog box.

5. Enter the tag properties and click on [OK].  
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To specify tag attributes, place the cursor in the ap-
propriate window, backspace over any current values
and enter new values.

Field Number
DataMerge displays the field number.  As you insert
tags, field numbers (up to 750) are automatically up-
dated.  Note that you cannot edit this option.

Field Name
Enter the name of the variable data field (maximum
31 characters).  If you use the space bar to separate
words, DataMerge automatically inserts an under-
score ( _ ) in that space. 

Comment
Select this option and enter a comment (maximum 31
characters) about the field in the text box that
displays.

Field Length
Enter the maximum number of characters allowable in
the specified field.  Note that if the variable data item
requires less than the maximum number of charac-
ters, the paragraph will be formatted so that there are
no extra spaces between the variable data item and
any following text.

Make sure any non-replacement characters are also
included in the field length.  For example, if you want
the date to appear in the field as follows:  **/**/**
(where * is the specified replacement character),  you
must enter the number 8 in the field length window. 

Tag Field Depth
This option is reserved for future use.

Replacement Character
Variable data fields are denoted in the document by a
string of replacement characters.  Replacement char-
acters are usually  @, !, #, or " characters, unless you
specify a set of replacement characters in the [Re-
placement Characters] option in the Setup menu
within DataMerge.  See the "DataMerge operation for
DOS" chapter for more information.

If you want to change the current replacement charac-
ter, backspace over the default character and enter a
new one.
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Field End Character
This option is reserved for future use.

Field Gen
Select this option, and in the text box that displays,
enter the non-replacement characters as you want
them to appear in relation to the replacement charac-
ters.  Maximum field length is 31 characters.

For example, to separate the month, day, and year in
the date field with slashes, you would type **/**/**
(where * is the replacement character you specified).
To print the telephone number, you may want to type
(***)***-**** (where * is the replacement character you
specified).  

Delete After Use
Select this option if you use the same field name in
multiple forms, but require different values for each
use.  

Deselect this option if you use the same field name in
multiple forms with the same data value for each use.

The default is selected.

If you select this option, select the [Use Data Field
Name] option when running DataMerge in Windows or
the [-USENAME] parameter when running DataMerge
from the Dispatcher or from the DOS command line.
See the applicable "DataMerge operation" chapter.

Mandatory/Optional
This option is reserved for future use.

Multi-Data
This option is reserved for future use.

Store to Tag List
Select this option to add this tag to the current tag list.

Modify Text Properties
Click on this button after selecting an existing data tag
to access the Text toolbox.  You can change the tag
text attributes using the options in the Toolbox.

When the information in the Data Tagging dialog box
is complete, click on [OK] to save the attributes to
disk.  A tag displays in the selected location.
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Using existing data tags

With Elixir Form software, you can use existing data
tags by loading tag files from the Tags directory speci-
fied in the Filing Options dialog box.  Tag file names
are stored with your .ELX file.

To use existing data tags:

1. <Ctrl>-click on the [Data Tags] option.

A window displays at the bottom of the Work
area.

2. Pull down the File menu in the window and
select [Load].

The Load Tag File dialog box displays with a list
of tag files.  Each file contains one or more indi-
vidual data tags.

3. Select a tag file and click on [OK].

The tag file name displays in the window header
and the data tags contained within the file display
in the window.

4. Select the data tag you want to copy to the
current form, drag it to the desired location on
the form, and release the mouse button.  

The data tag becomes part of your form.

Note that if you drag and drop a tag while in add
text mode, the tag jumps to the cursor position
when you release the mouse button and is em-
bedded in the paragraph.  If you are not in add
text mode when you drop the tag, you can drop
the tag at any location on the form.   

The tag file window displays the following additional
menus and options:
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Tag file window File menu

New
Displays a new tag file window.  The window header
reads "untitled" until you save the file with a name.  If
you save the form without specifying a tag file name,
the tag file is saved as filename.TAG where filename
is the name of the .ELX file.

Load
Displays the Load Tag File dialog box with a list of ex-
isting tag files you can load.

Merge
Displays the Merge Tag File dialog box.  Select a tag
file to merge the data tags it contains with the data
tags in the currently loaded tag file.  The data tag field
numbers are renumbered to prevent duplicate
numbers.

Save
Saves the current tag file with the data tags that dis-
play in the window.

Save as
Saves the current tag file under a different file name.

Tag file window Edit menu

Create
Displays the Data Tagging dialog box to allow you to
specify tag attributes for a new tag.

Edit
Displays the Data Tagging dialog box to allow you to
make changes to a selected tag's attributes.  You can
also right-click on a tag to display the dialog box.

Delete
Deletes the currently selected data tag from the tag
file.
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Viewing data tags

Replacement character strings show the position of
the tag.  If you do not see the replacement character
string, the font you are using may not contain the
specified replacement character and you must select
another character.

To check if a particular font contains the replacement
character you have specified:

1. From the Text toolbox, select the [Soft
Keyboard] option.

The soft keyboard displays at the bottom of the
screen.  

2. Use the scroll arrow to scroll through the font
characters.

Note that the maximum size of a tag that you can dis-
play on the screen is 2000 bytes.  A tag greater than
2000 bytes in size displays on the form as a line of
text with the tag name and all of its attributes, not as a
series of replacement characters.

Editing data tags

You can edit the parameters and the text parameters
for a data tag. 

To edit the parameters for a data tag:

1. Select the Select/Edit tool.

The Select/Edit toolbox displays.

2. Place the cursor on the replacement character
string you want to edit

If you cannot see the tag replacement character
string, press <Ctrl> + <T> to show fields.

3. Click the right mouse button.

The Data Tagging dialog box displays.
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4. Place the cursor in the window of the option
you want to edit.

5. Backspace over the current parameter and
enter a new parameter.

6. Click on [OK].

To edit the text properties: 

1. Select the Select/Edit tool.

The Select/Edit toolbox displays.

2. Place the cursor on the replacement character
string you want to edit

If you cannot see the tag replacement character
string, press <Ctrl> + <T> to show fields.

3. Click the right mouse button.

The Data Tagging dialog box displays.

4. Click on [Modify Text Properties].

5. Select the new options from the Text toolbox.

6. Click the right mouse button to end editing
the text display settings.

Note that if you change an attribute in a data field
which is repeated more than once on the form, the
Data Tag Change dialog box displays. 

To apply the changes to all tags with the same
field number, click on [Yes]. 

To apply the changes to this tag only, click on
[No].  The tag is saved as a new tag and as-
signed the next sequential number.   

Deleting data tags

To delete a tag:

1. Select the Select/Edit tool.

ADDING TAGS

2-18 ELIXIR TECHNOLOGIES CORPORATION



The Select/Edit toolbox displays.

2. Select the tag replacement character string
you want to delete.

If you cannot see the tag replacement character
string, press <Ctrl> + <T> to show tags.

3. Select the [Delete] option or press the <Del>
key.

The tag and all the tag attributes are deleted from the
form.

Moving data tags

To move a tag: 

1. Select the Select/Edit tool.

2. Select the direction for moving: [Horizontal
only], [Vertical only], or [Free].

3. Double click on the tag replacement character
string you want to move.  

The screen pointer changes to a hand.

If you cannot see the tag replacement character
string, press <Ctrl> + <T> to show tags.

4. Drag the tag replacement character string to a
new position. 

5. Release the mouse button. 

The tag replacement character string displays in
the new location. 

Copying data tags

To copy a tag:

1. Select the Select/Edit tool in the Toolbox.

2. Select the [Copy] option.
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3. Select the direction for copying: [Horizontal
only], [Vertical only], or [Free].

4. Click on the replacement character string you
want to copy.

Boxes appear around the data field to show it is
selected.

5. Click on the up or down arrow to select the
number of copies between 1 and 99.

6. Drag the replacement character string in the
direction you want to place the duplicate
fields.

When you copy tags, all of the tag attributes, including
the field number, are copied also.

Adding a graphics call

A graphics call defines the location of a graphic refer-
enced in the .DAT file.  You can have up to 9 graphics
calls per form.  

To insert a graphics call:

1. Select the Image tool to display the Image
toolbox.

2. Hold down the <Ctrl> key and select the [Load
Image] option.

The Load Image dialog box displays.

3. Select &&merge1.LP3 to load the first
graphics call.  

4. Click on [OK].

5. Press and hold the left mouse button.

The graphics call attaches to the screen pointer.

6. Position the screen pointer where you want
the graphic to load on the form and release
the left mouse button.
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7. For the second and subsequent graphics
calls, select &&merge2.LP3 and so on up to
&&merge9.LP3. 

Note that the maximum number of graphics calls per
form is 9. 

Deleting a graphics call

To delete a graphics call:

1. Select the Select/Edit tool.

The Select/Edit toolbox displays.

2. Click on the graphics call you want to delete.

Boxes appear around the graphics call to show it
is selected.

3. Click on the [Delete] option.

You can also pull down the Edit menu and select
[Delete] or press the <Del> key on the keyboard. 

To undo the delete operation, select the Undo icon in
the Toolbar, or pull down the Edit menu and select
[Undo].

Moving a graphics call

To move a graphics call:

1. Select the Select/Edit tool.

The Select/Edit toolbox displays.

2. Select the direction for moving: [Horizontal
only], [Vertical only], or [Free].

3.

Boxes appear around the graphics call to show it
is selected.

4. Drag the graphics call to a new location. 
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5. Release the mouse button to lock the image
on the form.

You can also move a selected graphics call by enter-
ing new coordinates:

1. Click on the values displayed in the current
object coordinates window in the toolbar. 

If you cannot click on the current object coordi-
nates, make sure the image is selected and click
the right mouse button.

2. Backspace over the old values or press the
<Del> key to delete the whole number.

3. Enter new coordinate values. 

The graphics call adjusts to the new coordinates when
you click the left mouse button or press <Enter>.

Copying a graphics call

To copy a graphics call:

1. Select the Select/Edit tool.

2. Select the graphics call you want to copy. 

Boxes appear around the graphics call to show it
is selected.

3. Select the [Copy] option.

4. Click on the up or down arrow to specify the
number of copies. 

5. Select the direction for copying: [Horizontal
only], [Vertical only], or [Free].

Drag the graphics call in the direction you want the du-
plicate graphics call(s) to display.
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Tagging Windows-based documents

This section applies only to users with Elixir Print-
Driver installed.  To merge and print the document,
you must first convert to Elixir (.ELX) format using the
Elixir PrintDriver.  See your Elixir PrintDriver User
Guide for information about using Elixir PrintDriver. 

You can tag a Windows-based document either by
referencing a data field in an external tag attribute file
or by pasting in a data field using ElixiTag. 

Note that, in Windows-based documents, you can
only specify left-justified text for DataMerge tags.  You
cannot use center, right, and full column justification
as the width of variable data characters may not cor-
respond to the width of control characters.

Referencing data fields in an external tag attribute file

To use this method of tagging a document, you must
create an external tag attribute file using the default
tag file name: drive:\ELIXIR\DTTAGS.TAG.  See the
"External tag attribute files" section in this chapter for
information on how to use ElixiTag to create an exter-
nal tag attribute file.   

To reference a data field in an external tag attribute
file:

1. Load an existing or new document into your
Windows application. 

2. Place the cursor where you want the first
character of the variable data to display.

3. Enter the following, depending on the format
of your .DAT file.  (See the "Data files" chapter
for information about the format of .DAT files.)

If your .DAT file follows format 2 or 3, you can
enter

%%n;
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n
is the number of the data field you are refer-
encing, for example,  %%1;

If your .DAT file follows format 1, 2, or 3, you
can enter

%%n fieldname;

n
is the number of the data field you are refer-
encing.

fieldname
is the name of the data field you are referenc-
ing.

For example,  %%2 ADDRESS;

Note that there is a space between the num-
ber and the fieldname.

DataMerge only uses field names if using for-
mat 1 in the .DAT file and if specified when
merging.  See the "Format 1" section in the
"Data files" chapter for more information.

4. Continue to enter text and add fields as
required.

Pasting tags from ElixiTag

To paste an ElixiTag in a Windows-based document:

1. From the Program Manager in Windows,
double-click on the ElixiTag icon.

The ElixiTag dialog box displays.
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            Figure 2-6.  ElixiTag dialog box.

2. Pull down the File menu and select [Open]

The Open dialog box displays.

           Figure 2-7.  Open dialog box 

3. Select an external tag attribute file and click
on [OK].

The ElixiTag dialog box displays the first data
field.

4. Click on [Copy] to copy the tag information to
the clipboard.
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5. Start your Windows documentation
application and open the document you want
to tag.

6. Position the cursor on the document where
you want to place the tag and click the left
mouse button.

7. Press <Ctrl> + <V> or select the [Paste] option
in your application.  

See your application user guide for information on
how to paste from the clipboard.

The control characters, field number and any tag
replacement characters display in the document.
Note that it takes five characters to define a tag.
Replacement characters are added in the tag if
the field length is more than five characters so
that the tag is approximately the length of the
field.   

8. Return to the ElixiTag dialog box and

as described.

Editing tags in a Windows-based document

If you want to edit a tag after you have pasted it into
your Windows application, you must delete the tag
from your document, edit the tag using ElixiTag and
re-paste the tag into your document.  

Deleting tags in a Windows-based document

To delete a tag in your document, follow the instruc-
tions in your document user guide for deleting text. 
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3.  Data files

This chapter describes how to create data files and
job print ticket files, and then preview a form(s)
merged with variable data using ElixirViewer.  

Data files are ASCII files with .DAT extensions that
contain the information for merging Elixir (.ELX) for-
mat forms with variable data ready for printing on a
Xerox production printer, an HP LaserJet Series II or
compatible PCL 4 printer or a PostScript printer.

Job print ticket files are ASCII files containing com-
mands that control the overall printing job.         

Preparing a .DAT file

A .DAT file contains printer commands, .ELX form ref-
erences, variable data and graphics calls.  The follow-
ing section describes how to create and format a
.DAT file.

The default directory for .DAT files is
drive:\ELIXIR\DOCS\DOCLIST.  To change the de-
fault directory, see the "Changing the default directory"
section in this chapter.

Viewing a sample .DAT file

If you selected to install the sample application during
installation, you can view the sample .DAT files:
RAFFLE1.DAT, RAFFLE2.DAT and RAFFLE3.DAT
using any text editor.  The .DAT files are stored in the
following directory:

drive:\ELIXIR\DOCS\DOCLIST

drive
is the drive where you installed DataMerge.
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Each sample .DAT file is created using a different for-
mat.  For more information about the different formats
for a .DAT file, see the "Adding variable data and
graphics calls" section in this chapter. 

If you did not install the sample application and you
want to view the .DAT files, reinstall DataMerge and
make sure you select the [Application] option in the
Files To Install window during installation.

Creating a .DAT file 

You can create a .DAT file using any text editor.  The
following section describes how to create a .DAT file
using Notepad.  

To create a .DAT file using Notepad:

1. Open the Elixir Desktop.

2. Double-click on the Documents folder.

3. Double-click on the Elixir Documents folder.

Pull down the File menu and select [New].  The
File Name Entry dialog box displays.

4. Enter a stem name for the new file (up to 8
characters).

5. Click on [OK].

A .DAT file icon with the name of your file displays
in the Elixir Documents folder.  

6. Double-click on the .DAT file icon to launch
the Notepad.  

You can now add the printer commands, form refer-
ences, variable data and graphics calls as described
in the following sections.    
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Adding a printer command

Commands for the printer must be placed in the .DAT
file before the page they effect.  Precede the com-
mand name with two $ signs.  For example, to print in
simplex mode, type the following:

$$SIMPLEX

Note that commands in the .DAT file override any dia-
log box or Setup menu options, or settings in the job
file.

For information about setting commands for the over-
all print job, see the "Job print ticket file" section in this
chapter.

This section shows the command (in bold) and the
function of the command (underneath).  These com-
mands are only applicable if your printer supports the
function. 

$$SIMPLEX
Prints all subsequent pages in simplex (one-sided)
mode.

$$DUPLEX
Prints all subsequent pages in duplex (double-sided)
mode.

$$DUPLEXINVERT
Prints all subsequent pages in inverted duplex (in-
verted and double sided) mode.

$$INPUTTRAY n
Specifies the input tray number to be used, where n is
the number of the tray.

In the Xerox production printer, 0=no tray, 1=MAIN,
2=AUX3, 3=MAIN, 4=AUX, 5=AUX2, 6=AUX2.

Make sure clusters and stock sets are defined in 
ELIXIR.JSL (see your Xerox printer manual).

$$OUTPUTTRAY
Specifies the output tray number to be used, where n
is the number of the tray.
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$$COPIES n
Specifies the number of copies of a form to be printed,
where n is the number of copies.

$$RESET
Resets the printer. 

$$CALLFORMS
Calls forms from the printer instead of the metacode
file.  The .FRM file, including any fonts, logos and im-
ages, must be on the printer to use this option.  When
you convert the .ELX file to .FRM, make sure you se-
lect the [Include Only Fonts Used] option in the Xerox
Form Converter Options dialog box.

$$NOCALLFORMS
Calls forms from the metacode file. 

Adding a form reference

Forms for use with DataMerge must be in Elixir (.ELX)
format and must contain tags to indicate the location
and attributes for the variable data and any graphics
calls.  See your Elixir PrintDriver User Guide for infor-
mation on converting your Windows-based document
to Elixir (.ELX) format.  See the "Adding tags" chapter
for information about adding tags and graphics calls.  

The default directory for forms is
drive:\ELIXIR\FORMS\ELIXIR\.  To change the default
directory, see the "Changing the default directory"
section in this chapter.

Place Elixir (.ELX) form references after any printer
commands for that page and before the variable data.

Precede the stem name of the form with two % signs
and the directory path.  For example, to merge vari-
able data onto a form named BOND.ELX, type the
following:

%%ELIXIR\FORMS\ELIXIR\BOND.ELX

The file extension is optional.

Note that if no path is specified, DataMerge looks for
the form in the default directory.  
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You can copy form references from the default forms
folder into an existing .DAT file or create a new .DAT
file.

To copy a form reference into an existing .DAT file:

1. Open the Elixir Desktop.

2. Double-click on the Forms folder.

3. Double-click on the Elixir Forms folder.

4. Drag the form you want copy to the .DAT file
and drop it on the clipboard.  

To select multiple forms, hold down the <Shift>
key, and drag and drop the forms on the
clipboard.

5. Double-click on the Documents folder.

6. Double-click on the Elixir Documents folder.

7. Drag and drop the .ELX file from the clipboard
to the .DAT file.

The form reference(s) is copied into the .DAT file.

Adding variable data and graphics calls

Place the variable data and graphics calls into the
.DAT file after the form reference.  

The default directory for graphics is
drive:\ELIXIR\PICS\PRINTER.  Note that if no path is
specified in the .DAT file,  DataMerge looks for the
graphic in the default directory.  To change the default
directory, see the "Changing the default directory"
section in this chapter.

Enter the variable data and graphics calls using one of
three formats:
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Format 1 (recommended)

Precede each variable data item with the field-
name and an = sign, and separate each variable
data item with a carriage return.  

For example: fieldname=variable data

fieldname
is the name of the field specified in the DataTag-
ging dialog box or the external tag attribute file.

variable data
is the variable data you want to display on the
form.

Precede the stem name of the graphic with
&&MERGEn= where n is number 1 through 9,
and add to your .DAT file after the variable data.

When you use this format, you must specify that you
want to merge using the field name: 

If you are running DataMerge from Windows, se-
lect the [Use Data Field Name] option in the HP
Options dialog box for HP/PCL printing or the
PostScript Options dialog box for PostScript print-
ing, or specify the [-USENAME] parameter on the
command line when running in batch mode from
the Dispatcher, . 

For information about these options, see the "Da-
taMerge operation for Windows" chapter.

If you are running DataMerge from the DOS, use
the [-USENAME] parameter on the command
line.

For more information see the "DataMerge opera-
tion for DOS" chapter.

The following is an example of a .DAT file using this
format.  NAME, STREET, and STATE are the field-
names.  DAYNIT and BABY are the names of the
graphics.  Note that the order of the variable data
items does not matter.  
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%%ARFORM1
NAME=Elixir Technologies Corporation
STREET=P.O. Box 1559
STATE=Ojai CA. 93024
&&MERGE1=BABY
&&MERGE2=DAYNIT
%%ARFORM1
STATE=Seattle WA 91301
NAME=Mr. Doe
STREET=1234 Washington Avenue
&&MERGE2=DAYNIT
&&MERGE1=BABY

File extensions are optional.

If you installed the sample application during installa-
tion, view the sample file RAFFLE1.DAT for another
example of a .DAT file that uses this format. 

Format 2

Place the variable data in the order it is to appear
on the form and separate each variable data item
with a carriage return.  

Variable data items are placed onto the form
based on their position in the data set.  For exam-
ple, the first data item following the form refer-
ence is placed on the form where field number
one occurs, the second data item is placed on the
form where field number two occurs, and so on.  

Place the stem name of the graphic(s), preceded
by two & signs after the variable data and in the
order they are to be merged onto the form.

The following is an example of a .DAT file using this
format:  
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%%ARFORM1
Elixir Technologies Corporation
P.O. Box 1559
Ojai CA. 93024
&&BABY
&&DAYNIT
%%ARFORM1
Mr. Doe
1234 Washington Avenue
Seattle, WA 91301
&&BABY
&&DAYNIT

File extensions are optional.

If you installed the sample application during installa-
tion, view the sample file RAFFLE2.DAT for another
example of a .DAT file that uses this format.

Format 3

Place the variable data in the order it is to appear
on the form and separate each variable data item
with a character delimiter.  

Place the stem name of the graphic(s), preceded
by two & signs after the variable data and in the
order they are to be merged on the form.

When you use this format, you must specify the delim-
iter character: 

If you are running DataMerge from Windows,
specify the delimiter character in the [Delim-
iter] option in the HP Options dialog box for
HP/PCL printing or the PostScript Options
dialog box for PostScript printing, or specify
the [-D:value] parameter on the command
line when running in batch mode from the
Dispatcher, . 

For information about these options, see the
"DataMerge operation for Windows" chapter.
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If you are running DataMerge from the DOS,
use the [-D:value] parameter on the com-
mand line.

For more information see the "DataMerge op-
eration for DOS" chapter.

The following is an example of a .DAT file using a
comma as the character delimiter:

%%ARFORM1,Elixir Technologies Corporation,P.O.
Box 1559,Ojai CA. 93024,&&BABY,&&DAYNIT
%%ARFORM1,Mr. Doe,1234 Washington Ave-
nue,Seattle, WA 91301,&&BABY,&&DAYNIT

File extensions are optional.

Note that there are no spaces between form refer-
ences and between each variable data item.  Only the
character delimiter separates each item.

If you installed the sample application during installa-
tion, view the sample file RAFFLE2.DAT for another
example of a .DAT file that uses this format.

Changing the default directory

If no directory is specified in the .DAT file, DataMerge
looks for resources in the default directories.

The default directories are:

Forms (.ELX)
drive:\ELIXIR\FORMS\ELIXIR\

Screen fonts 
drive:\ELIXIR\FONTS\SCREEN\

Images or graphics (.LP3)
drive:\ELIXIR\PICS\PRINTER\

Text files (.DAT and .JOB)
drive:\ELIXIR\DOCS\DOCLIST\
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Before you can change a default directory, you must
pull down the System menu, select [User Privileges]
and select the [Backup beyond default directories]
option. 

To change a default directory from the Elixir Desktop:

1. Pull down the System menu and select [Usage
Switches].

The Usage Switches dialog box displays.

2. Select [Save Settings on Exit] and click on
[OK].

3. Open the appropriate Elixir folder on the
Desktop (Forms, Fonts, Graphics, or
Documents) and then open any of the Elixir,
Input, or Output folders.

The default directory displays in the header.

4. Use the backup button to backup and change
to the directory you want as the default.

5. Exit/close the folder

The default directory is changed in the SYSTEM.INI
file.

Editing a .DAT file

You can view and edit a .DAT file from the Elixir
Desktop.

To edit a .DAT file:

1. Open the Elixir Desktop.

2. Double-click on the Documents folder.

3. Double-click on the Elixir Documents folder.

4. Double-click on the .DAT file you want to edit.
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The Notepad application launches and the .DAT
file contents display. 

5. Add, delete or modify the .DAT file text as
required.

6. Pull down the File menu and select [Save].

To save the file with a different name, select
[Save as] and enter a new name for the file.

7. Pull down the File menu and select [Exit].

Notepad closes and the edits are saved in the .DAT
file.

Previewing a merged form

You can preview a merged form before you print using
ElixirViewer.

Launching ElixirViewer

To launch ElixirViewer and preview a merged form:

1. Open the Elixir Desktop.

2. Double-click on the Documents folder.

3. Double-click on the Elixir Documents folder.

4. Drag and drop the .DAT file you want to
preview onto the Viewer icon.

A dialog box displays. 

5. Enter the following:  PWL_LE.EXE

ElixirViewer is launched and the merged form(s)
displays.
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Viewing a file 

You can easily move around the file using icons in the
Toolbar.

Note that some of the options in ElixirViewer are not
valid for DataMerge and may be grayed out. 

GoTo Page
To move to another page, click on the GoTo Page
icon.  The Page Number dialog box displays.

Figure 3-1.  Page number dialog box

Enter a page number in the [Document] option and
click on [OK].  The screen displays the selected page.
Page up
To move to the top of the page or to the previous
page, click on the Page Up icon or press the Page Up
key on your keyboard.
Page down
To move to the bottom of the page or to the next page
click on the Page Down icon or press the Page Down
key on your keyboard.

Zoom
To zoom in or zoom out on an area of the page, click
on the [+] or [-] scroll arrow on either side of the zoom
icon in the Toolbar.  You can also use the <+> and
<-> keys on the numeric keyboard to zoom in and out.

The highest magnification of a form is [8x] and the
lowest magnification is [-8x]. 

Opening another data file  <F9>

To view another .DAT file:
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1. Pull down the File menu.

2. Select [Open Data File].  

The Open Document dialog box displays.  

Figure 3-2.  Open Document dialog box

3. Select the .DAT file you want to view.

4. Click on [OK].

The merged form displays.

Printing a data file

To proof print a form with the merged data, click on
the printer icon.  The Print dialog box displays. 
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Figure 3-3.  Print dialog box

Select options from the Print dialog box and click on
[OK].  The following options display in the Print dialog
box:

Printer
Choose your printer as a PCL 4 or compatible, Xerox
4045 or Xerox 2700/4045 printer.

PCL 4 considerations
PCL4 output for letter and legal sized forms con-
tains an approximate 0.25-inch non-printable area
for all margins.  For example, if any elements on
your form extend into this non-printable region
they will not print. 

For accurate positioning, shift the print image on
the page using the Page Shift option in the Print
dialog box.

Xerox 4045 considerations
The Xerox 4045 does not print characters in cell
positions below HEX 20.
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PDF format
If you have Adobe's PDFWriter printer driver in-
stalled on your PC, you can convert your form to
PDF format by selecting [PDF ON FILE:] from this
window.  When you select this option, you are
prompted for the directory and file name.

Orientation
Select the orientation for your page, [Landscape] or
[Portrait].

Page shift
Select [Page Shift] to shift your proof printer output
horizontally or vertically by the number of dots speci-
fied.  The Xshift moves your form horizontally and the
Yshift moves your form vertically.

Use a negative shift value to shift the print output to
the left or down and a positive value to shift your form
up or right.

The default setting for the page shift is 0.  However,
you may need to change the shift after some initial
testing.  For a PCL 4 or compatible printer, the normal
or centered image value is Xshift = -60.

Copies
Select the number of copies you want to print.

Print to file
ElixirViewer allows you to print a file to disk, and to
proof print the form from the disk file. This allows you
to proof print your form from any PC connected to one
of the supported proof printers (with or without Elixir-
Viewer installed on the PC).

To print your form to a disk file for proof printing, all
proof printer versions of the fonts used in the form
must be resident on the proof printer.  Select your
proof printer, and then select one of the following op-
tions to load fonts:

Select [Always] to download fonts every time you
print a form.

Select [Once] to download fonts as soft fonts on
the printer.  Fonts are identified by an index num-
ber, and are managed and accessed through the
[Print Manager] option in Windows.
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Select [Never] to use the soft fonts previously
downloaded to your printer.  Fonts are referenced
by index numbers, and no new fonts are
downloaded.

Note that if you select [Once] or [Never], you should
use the same font list in your form as on your printer.
If you use a different font list, the index number may
represent a different font.

When you click on [OK], you are prompted to enter a
file name. Enter up to eight characters for the stem
name of the file and click on [OK].. 

ElixirViewer creates print files and font files with the
following extensions in the appropriate
drive:\ELIXIR\PRINTS\ sub-directories:

For HP PCL printers, .PRN files are placed in the
drive:\ELIXIR\PRINTS\HPPRINT directory.

For Xerox 4045 (2.0) printers, .PRN and .FNT
files are placed in the
drive:\ELIXIR\PRINTS\X45PRINT directory.

For Xerox 2700 or Xerox 4045 (2.1) printers,
.PRN  and .FNT files are placed in the
drive:\ELIXIR\PRINTS\X27PRINT directory.

Print pages
Enter the range of pages to print or select [All pages]
to print all pages in the file.

Exiting ElixirViewer

To exit ElixirViewer and return to the Elixir Desktop,  
use one of the following methods:

Press <Alt> + <F4>.

Pull down the File menu and select [Exit].

Double-click on the Close button in the top left
corner of the screen. 
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Job print ticket file

A job print ticket file is an ASCII file containing com-
mands that control the overall printing job.  Note that
commands in the .DAT file override settings in the job
file.

You can use any text editor to create a job print ticket
file.  Save the file in the same directory as the .DAT
file with any name and extension.  .JTK or .JOB is the
recommended extension.

Adding commands

The following section describes commands (in bold)
you can specify in a job print ticket file and the func-
tion of the command (underneath).  Each command
ends with a semi-colon and a carriage return.

Note that these commands are only applicable if your
printer supports the function.

COPIES=n
Specifies the number of copies of a form to be printed,
where n is the number of copies.

INPUT_BIN=n
Specifies the input tray number to be used, where n is
the number of the tray.

In the Xerox production printer, 0=no tray, 1=MAIN,
2=AUX3, 3=MAIN, 4=AUX, 5=AUX2, 6=AUX2.

Make sure clusters and stock sets are defined in 
ELIXIR.JSL (see your Xerox printer manual).

OUTPUT_BIN=n
Specifies the output tray number to be used, where n
is the number of the tray.

RESET_AFTER_JOB=YES
Resets the printer after job completion.

RESET_AFTER_JOB=NO
Does not reset the printer after job completion.

DATA FILES

DATAMERGE USER GUIDE 3-17



SIDES_PRINTED=SIMPLEX
Prints all pages in simplex (one-sided) mode.

SIDES_PRINTED=DUPLEX
Prints all pages in duplex (double-sided) mode.

SIDES_PRINTED=DUPLEXINVERT
Prints all pages in inverted duplex (inverted and dou-
ble sided) mode.

CALLFORMS=YES
Calls forms from the printer instead of the metacode
file.  The .FRM file, including any fonts, logos and im-
ages, must be on the printer to use this option.  When
you convert the .ELX file to .FRM, make sure you se-
lect the [Include Only Fonts Used] option in the Xerox
Form Converter Options dialog box.

CALLFORMS=NO
Calls forms from the metacode file, not the printer. 

Duplicate commands

Some of the same commands can be specified in the
job print ticket file, the data file and the Setup menu.
Settings in the job print ticket file override settings in
the Setup menu and settings in the data file override
settings in Setup menu and settings in the job print
ticket file.  

Sample job print ticket file

This section shows a sample job file where all pages
are printed in simplex mode, the paper output tray is
tray number 2 and the reset command is sent to the
printer after the job is completed.

SIDES_PRINTED=SIMPLEX
OUTPUT_BIN=2
RESET_AFTER_JOB=YES.
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4.  DataMerge operation
 for Windows

This chapter describes how to set up options and
merge variable data with a form for output to HP PCL
or PostScript format from the Elixir Desktop.  

To see the DataMerge dialog boxes described in this
chapter,  you must have DataMerge installed on the
same drive as your Elixir Desktop.

To set up options and output to HP PCL, Postscript or
Xerox format using the DOS DataMerge interface, see
the "DataMerge operation for DOS" chapter. 

Printing to the printer

The following section describes how to merge and
print forms to an HP PCL or PostScript printer interac-
tively using the Elixir Desktop.  PCL print files are
stored in drive:\ELIXIR\DOCS\HPOUT and PostScript
print files are stored in drive:\ELIXIR\DOCS\PSOUT.

To merge and print a form to the printer:

1. Open the Elixir Desktop.

2. Double-click on the Documents folder.

3. Double-click on the Elixir Documents folder.

The .DAT files display.

4. Drag the .DAT file you want to print to the
Printers icon.

The DataMerge Options dialog box displays.
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Figure 4-1.  DataMerge Options dialog box.

5. Select [Merge Data]

6. Select the printer and click on OK.   

See the following sections for HP PCL and Post-
Script Option dialog box options.

The form(s) is merged with the variable data and
printed to the printer.  The HP PCL print file is
stored in drive:\ELIXIR\DOCS\HPOUT and the
PostScript file is stored in
drive:\ELIXIR\DOCS\PSOUT.

HP PCL printing options

When you select [HP PCL], the HP Options dialog
displays.
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Figure 4-2.  HP Options dialog box.

The HP Options dialog box contains the following
options:

Merge Name
The name of the .DAT file displays.  Note that you
cannot edit this field.

Output Name
This option is valid only when printing to disk.   

External Tag Attribute File
If your form references data fields in an external
tag attribute file, enter the name of the file.  For
more information on external tag attribute files,
see the "Adding tags" chapter.

Output Device
Select the printer port: [LPT1], [LPT2] or [LPT3].

Justify Text
Specify how the text is positioned on the page:

Select [Words] to justify text by increasing or
decreasing the space between words.

Select [Characters] to justify text by increas-
ing or decreasing the space between charac-
ters.  This option makes the form easier to
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read but the file size is larger and takes
longer to print.  

Delimiter
This option is only valid when using Format 3 de-
scribed in the "Data files" chapter.  Enter the
character, or the decimal value for the character,
that separates the variable data in the data file.

Use Data Field Name
This option is only valid when using Format 1 de-
scribed in the "Data files" chapter.  

Select this option to merge the variable data
by the field name. 

Deselect this option to merge the variable
data by the field number.

Tray Number
Specify the input paper tray number.

Sides Printed
Specify how you want the file to print:

Select [Simplex] to print on one side of the
paper only.

Select [Duplex] to print on both sides of the
paper.

Output Fonts
Select this option to download your fonts to the
printer.  If this option is selected, make sure the
fonts are converted to HP PCL format.  For infor-
mation on converting fonts to HP PCL format, see
your Elixir Desktop User Guide.

Shift Printer Output
This option allows you to specify the number of
dots to shift the output horizontally and vertically.
The typical value for HP Series II printers is -60.

Macro Number
Enter a macro number, between 1 and 32767, for
storing a single page job in the printer memory for
later callout as a macro.  
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If you do not want to assign a macro number, en-
ter 0.  The default is 0.  This option is for forms
without variable data.

PostScript printing options

When you select [PostScript], the PostScript Options
dialog box displays.

Figure 4-3.  PostScript Options dialog box.

The PostScript Options dialog box contains the
following options:

Merge Name
The name of the .DAT file displays.  Note that you
cannot edit this field.

Output Name
This option is valid only when printing to disk.   

External Tag Attribute File
If your form references data fields in an external
tag attribute file, enter the name of the file.  For
more information on external tag attribute files,
see the "Adding tags" chapter.

Output Device
[LPT1], [LPT2] or [LPT3].

Justify Text
Specify how the text is positioned on the page:
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Select [Words] to justify text by increasing or
decreasing the space between words.

Select [Characters] to justify text by increas-
ing or decreasing the space between charac-
ters.  This option makes the form easier to
read but the file size is larger and takes
longer to print.

Delimiter
This option is only valid when using Format 3 de-
scribed in the "Data files" chapter.  Enter the
character, or the decimal value for the character,
that separates the variable data in the data file.

Use Data Field Name
This option is only valid when using Format 1 de-
scribed in the "Data files" chapter.  

Select this option to merge the variable data
by the field name. 

Deselect this option to merge the variable
data by the field number.

  

Printing to disk

The following section describes how to merge and
print forms to disk interactively for subsequent output
to an HP PCL or PostScript printer using the Elixir
Desktop.  PCL print files are stored in
drive:\ELIXIR\DOCS\HPOUT and PostScript print files
are stored in drive:\ELIXIR\DOCS\PSOUT.

To merge and print a form to disk:

1. Open the Elixir Desktop.

2. Double-click on the Documents folder.
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3. Double-click on the Elixir Documents folder.

The .DAT files display.

4. Drag the .DAT file you want to print to the
Converters icon.

The Document Converter Options dialog box
displays.  

Figure 4-4.  Document Converter Options 
dialog box.

5. Select [Merge Data]

6. Select a printer and click on OK.   

See the following sections for HP PCL and Post-
Script Option dialog box options.

The form(s) is merged with the variable data and
printed to disk.  The HP PCL print file is stored in
drive:\ELIXIR\DOCS\HPOUT and the PostScript
file is stored in drive:\ELIXIR\DOCS\PSOUT.:

HP PCL printing options 

When you select [HP PCL] the HP Options dialog box
displays.
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Figure 4-5.  HP Options dialog box.

Specify the options in the dialog box.  For a de-
scription of these options, see the "HP PCL print-
ing options" heading in the "Printing to the printer"
section in this chapter, with the following
exceptions:  

Output Name
This option is valid when printing to disk only If
you want to rename your output file, click the
mouse in the window and enter a new name.  If
you do not enter a new name in the window, Da-
taMerge uses the merge name for the output file.

Output Device
Specify [Disk].

PostScript printing options

When you select [PostScript], the PostScript Options
dialog box displays.
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Figure 4-6.  PostScript Options dialog box.

Specify the options in the dialog box.  For a de-
scription of these options, see the "PostScript
printing options" heading in the "Printing to the
printer" section in this chapter, with the following
exceptions:  

Output Name
This option is valid when printing to disk only.  If
you want to rename your output file, click the
mouse in the window and enter a new name.  If
you do not enter a new name in the window, Da-
taMerge uses the merge name for the output file.

Output Device
Specify [Disk].

Operating DataMerge in batch mode 

You can operate DataMerge in batch mode from the
DOS command line directly or through the Desktop
Dispatcher.  For information about operating Da-
taMerge from the DOS command line, see the "Da-
taMerge operation for DOS" chapter.  

The following section describes how to set up a Da-
taMerge command line in the Desktop Dispatcher.
You can use the Desktop Scheduler to run the dis-
patcher command. See your Elixir Desktop User
Guide for detailed information about the Dispatcher
and the Scheduler utility.

DATAMERGE OPERATIONS FOR WINDOWS

DATAMERGE USER GUIDE 4-9



The DM.CFG file contains the settings specified in the
Options dialog boxes described previously.  When you
run DataMerge in batch mode from the Dispatcher,
you can specify parameters on the command line or
you can use the settings in the DM.CFG file.  

Note that if you are using format 1 in your .DAT file,
you must use the [-USENAME] parameter and if you
are using format 3 in your .DAT file, you must use the
[-D:value] parameter (where value is the delimiter
character used in your .DAT file).  See the "Data Files"
chapter for more information about .DAT file formats. 

To set up a command line in the Dispatcher: 

1. Click on the Dispatcher icon.

The Dispatcher Commands dialog box displays.

2. Add the following line:

drive:\ELIXIR\DM [filestemname] 
[jobfilename] [-optionalparameter]

drive
is the drive where DataMerge is installed.

filestemname
is the stem name of the .DAT file.

jobfilename
is the name of the job print ticket file with the
extension.

-optionalparameter
is an optional parameter (or parameters) as de-
scribed in the "Command line parameters"
appendix.

Note that if you do not specify any optional pa-
rameters, DataMerge uses the settings in the
DM.CFG file.  

(See previous note about using [-USENAME] and
[-D:value] parameters when the .DAT file follows
format 1 or 3.)  

3. Click on [Setup]
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The User Application Setup dialog box displays.

4. Select the following options: [DOS
application], [Send only Filename], [Command
is BAT file], [Pause after execution] and
[Window].

5. Click on [OK].

The Dispatcher Command dialog box displays.

6. Click on [Start].

DataMerge processes the .DAT file.

Note that you can also set up a command line with %1
instead of the filestemname and then drag a .DAT file
to the DIspatcher icon, select the command line and
click on [Start].    

DATAMERGE OPERATIONS FOR WINDOWS

DATAMERGE USER GUIDE 4-11



5.  DataMerge operation
 for DOS

This chapter describes how to setup options and
merge variable data onto a form for output to HP PCL
(or compatible), PostScript or Xerox format from the
DOS DataMerge interface.    

Note that your output depends on the ElixiKey you
have attached.

To set up options and output to HP PCL or PostScript
format using the Elixir Desktop, see the "DataMerge
operation for Windows" chapter. 

Accessing the DataMerge main screen

You can set up the default selections for DataMerge
from the main DataMerge screen.  To access the
main DataMerge screen, type DM at the drive where
Elixir is installed, for example, if Elixir is installed on
the C drive, type:

C:\>DM

The Main DataMerge screen displays.
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Figure 5-1.  Main DataMerge screen

Selecting menus

DataMerge uses a pull-down menu and dialog box
system.  To pull down a menu and select an option:

1. Use the left and right arrow keys on the
keyboard or on the numeric keypad to select  
a menu.  

You can also select a menu by typing in the first
letter of the menu, for example, type S for the
Setup menu. 

2. Press <Enter>.

A submenu displays.

Note that there is no submenu for the Info menu
or the Quit menu.

3. Use the up and down arrow keys on the
keyboard or on the numeric keypad to select a
submenu option.
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Use the <Home> or <PgUp> key to select the first
submenu option, and use the <End> or <PgDn>
key to move to the last submenu option.

4. Press <Enter>. 

5. Specify selection.

See the "Setting up DataMerge options" section
for detailed information about the submenu
options.  

6. Press <Esc> to exit from the submenu
display.

Setting up DataMerge options

Five main menus display at the top of the DataMerge
main screen.  See the previous section for information
on how to select a menu and display the submenu
options.

Info menu

To view the Information window, select the Info menu
and press <Enter>.  The Information window contains
details about your version of DataMerge.  If you expe-
rience problems using DataMerge, your customer
support representative will need this information. 

Press any key to exit the Information window.

Setup menu

To change or view the setup options, select the Setup
menu and press <Enter>.  The Setup submenu dis-
plays. 
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Figure 5-2.  Setup window

The Setup menu contains the following options.  To
save any changes, select [Save Setup Options] and
press <Enter>.   

Text Directory
Specify the directory where the data (.DAT) files are
stored.  The default text directory is
drive:\ELIXIR\DOCS\DOCLIST.

Forms Directory
Specify the directory where the Elixir (.ELX) format
files are stored.  The default directory is 
drive:\ELIXIR\FORMS\ELIXIR\DEMO.

Fonts Directory
Specify the directory where the font (.FNT) files are
stored.  The default directory is
drive:\ELIXIR\FONTS\SCREEN\DEMO. 

Output Format
Specify the output format for the job:

[HP] (Hewlett-Packard printer format)

[OFFLINE META] (Xerox metacode format
for off-line installations)
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[ONLINE META] (Xerox metacode format for
on-line, channel-attached installations)

[POSTSCRIPT] (For any postscript-
compatible printer)

[4235] (Xerox 4235 printer format)

[4700] (Xerox 4700 printer format)

[4045] (Xerox 4045 printer format)

[2700] (Xerox 2700 printer format)

Output Device
Specify the output device for your job:

[DISK]

[TAPE]

[LPT1]

[LPT2]

[LPT3]

Note that if you select [TAPE] and have no tape on the
system, DataMerge automatically writes the file to
disk.

Output Fonts
Specify whether or not the fonts are downloaded to
the printer  (HP PCL and XES only).

Select [YES] to download the required fonts
to the printer.

Select [NO] if you do not want to download
any font files to the printer.  Select this option
only if the required fonts already reside on the
output printer. 
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Justify text between
Specify how the text is justified: 

Select [WORDS] to justify text by increasing
or decreasing space between words.

Select [CHARS] to justify text by increasing or
decreasing space between individual charac-
ters.  This option makes the form easier to
read, but the file size is larger and takes
longer to print.

$DJDE Command String
Specify the Dynamic Job Descriptor Entry string that is
coded in the PREFIX statement of your printer's JSL.
The PREFIX statement specifies the string that delim-
its the start of a DJDE record within the normalized
metacode datastream. 

The DJDE command string can be up to ten charac-
ters long. It is important that the PREFIX statement
delimiter specified in DataMerge is identical to the de-
limiter specified in the PREFIX parameter of the JSL
used in your environment.

Duplex
Specify whether or not you want to print in duplex.

Select [YES] to print in duplex (on both sides
of the page).

Select [NO] to print on only one side of the
page.

Image Compression 
Specify how the image files are compressed.

Select [NONE] if you do not want .IMG files
compressed.

Select [PARTIAL] to partially optimize the
.IMG files. This setting compresses both
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duplicate lines and blank (null) lines within the
.IMG file.

Select [FULL] to optimize for white space
within lines in the .IMG file.  

This setting takes the longest time to print
and produces the smallest .IMG files. If you
are dealing with documents that have graphic
images of more than a half page and you are
printing on a Xerox 8700 or 9700 series
printer, you should select [FULL].

Included with DataMerge is a stand-alone utility called
METACOMP. METACOMP compresses metacode
files containing uncompressed IMG files.   See the
"Stand-alone utility chapter for more information on
this utility.

External Tag Attribute File
If your form references data fields in an external tag
attribute file, enter the name of the file.  For more in-
formation about eternal tag attribute files, see the
"Adding tags" chapter.

Replacement Characters 
Specify the Replacement Characters.  The default
characters are @, #, !, ". 

Make sure that the replacement characters are char-
acters that do not appear anywhere else in the text.

UDK Escape Code
Specify an escape code from 0-255.  The UDK es-
cape code separates printer commands from text to
be printed.

When outputting Xerox 4045 or 2700 format files, the
UDK escape code can be any character (or combina-
tion of characters) of your choice, as long as the code
is not found in the text file itself.

The default UDK escape code is 27.  You can not use
the default UDK escape code if you are printing to an
online, UDK printer.
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Shift Printer Output
This option allows you to specify the number of dots to
shift the output horizontally and vertically.  The typical
value for HP Series II printers is -60.

Tray Number
Specify the input tray number.

Macro Number/Priority
Enter a macro number, between 1 and 32767, for
storing a single page job in the printer memory for
later callout as a macro. (HP only) 

If you do not want to assign a macro number, enter 0.
The default is 0.  This option is for forms without vari-
able data.

Interface
Select the interface option:

Select [ASCII] to produce ASCII output for
writing to disk.

Select [EBCDIC] to produce EBCIDIC output
for Xerox printers connected to your PC via
coaxial cable and a protocol converter.

Select [SMARTBOX] if your PC is connected
to the printer through a Smartbox or Agile
protocol converter.

Job File Name
Specify the job file name.  A job file containing com-
mands that control the overall print job must be in the
directory specified in the [Text directory] option.  See
the "Data files" chapter for information about creating
a job file.

Save Setup Options
To save the current settings selected in the submenu
options of the Setup menu, select [Save Setup Op-
tions] and press <Enter>.  The settings are written to
disk and used when DataMerge is invoked. 
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DataEntry menu options

The DataEntry menu allows you to set up a new data
file (.DAT) or edit an existing one and tag an Elixir file.
See the "Data Files" chapter for detailed information
about creating a .DAT file using a text editor.

To view the DataEntry options, select the DataEntry
menu and press <Enter>.  The DataEntry submenu
displays. 

Figure 5-3.  DataEntry window

The DataEntry menu contains the following options:

Add Data
The [Add Data] option allows you to create a new data
file.

To create a new data file:

1. Select [Add Data] and press <Enter>.

The .DAT files in the text directory display.

DATAMERGE OPERATION FOR DOS

DATAMERGE USER GUIDE 5-9



Figure 5-4.  Add Data window.

2. Select [NEWFILE] and press <Enter>.

A New Data File Name window displays.

3. Enter a new file name and press <Enter>.

The Elixir form (.ELX) files in the specified forms
directory display.

4. Select a tagged .ELX form and press <Enter>.

A window displays a list of the tags on the form.

5. Enter the variable data for each tag.  

Use the down arrow on the keyboard to move to
the next tag in the list until all the tags are
completed.

6. Press <Enter> to end data entry and press
<Enter> again to return to the Forms directory
window.  

7. Press <Esc> to return to the DataEntry
submenu. 

To add data to an existing data file:

1. Select [Add Data] and press <Enter>.

DATAMERGE OPERATION FOR DOS

5-10 ELIXIR TECHNOLOGIES CORPORATION



The .DAT files in the specified text directory
display.  

2. Select the file you want to add data to and
press <Enter>.

The Elixir form (.ELX) files in the specified forms
directory display.  

3. Select a tagged form and press <Enter>.

4. Follow steps 5 - 7 for creating a new file
(described above). 

Edit Data
The [Edit Data] option allows you to view the data in a
.DAT file.  

To view a .DAT file:

1. Select [Edit Data] and press <Enter>.

The .DAT files in the specified text directory
display.  

2. Select the .DAT file you want to view  and
press <Enter>.

The variable data in the first form displays.

Figure 5-5. Edit Data window
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3. Press <Enter> to view the variable data in the
next form.  

4. Continue to press <Enter> to view the variable
data in the all the forms in the .DAT file. 

Tag Elixir File
This option allows you to specify and modify the attrib-
utes for data fields in form files referenced in a .DAT
file.

 To specify and modify attributes:

5. Select [Tag Elixir File] and press <Enter>.

The Elixir form (.ELX) files in the specified forms
directory display.

6. Select a tagged form and press <Enter>.

A window displays the list of attributes for the first
tag.

Figure 5-6.  Tag Elixir File window

7. Enter or edit the attributes for the first tag.

Use the up and down arrow keys on the keyboard
to move the cursor to the next field attribute.

See the "Adding tags" chapter for detailed infor-
mation about each field attribute.
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8. Press <Enter> to display and edit the
attributes of the next tag. 

Write Tag File
Use this option to create an external tag attribute file
An external tag attribute file specifies the attributes as-
sociated with tag position markers (%%n;) in a
Windows-based document.

See the "Adding tags" chapter for information about
creating an external tag attribute file using the ElixiTag
utility. 

To write a tag file:

1. Select [Write Tag File] and press <Enter>.

The .DAT files in the specified text directory
display.  

2. Select a .DAT file and press <Enter>.

3. Select a new tag file name with a .TAG
extension or press enter to accept the current
file name.

The default file is the file specified in the [External
Tag Attribute File] option in the Setup menu.

Figure 5-7.  Write Tag File window

DATAMERGE OPERATION FOR DOS

DATAMERGE USER GUIDE 5-13



DataMerge writes all tags and associated attributes
found in all the Elixir files referenced in the selected
.DAT file to an external tag attribute file. 

This file consists of %%n, where n is the Field Num-
ber followed by a list of the attributes for each field
number. You can create this file in any text editor, or
by using the [Write Tag File] option to create it
automatically.

If any Elixir form files contain data fields with missing
attributes, DataMerge uses the attributes from the ex-
ternal tag attribute file during printing.  Data fields with
all attributes specified are not overwritten by the tag
attributes found in the external tag attribute file.

Print Tags
You can print a report showing each DataMerge data
field and the tag attributes of Elixir files referenced in a
selected .DAT file.

To print a tag file:

1. Select [Print Tags] and press <Enter>.

The .DAT files in the specified text directory
display.  

2. Select a file and press <Enter>.

The report showing each data field is sent to the
printer specified in the [Output Format] option in
the Setup menu.

Print menu

The Print menu option allows you to print a .DAT file
to the printer specified in the Setup menu using the
[Output Format] option.

To print a .DAT file:

1. Select the Print menu and press <Enter>.

The .DAT files in the specified text directory
display.  
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Figure 5-8.  Print window

2. Select the .DAT file you want to print.

To move from one file to another, you can either
use the arrow keys on the keyboard, or you can
enter the first letter of the filename you want to
print (uppercase or lowercase). 

3. Press <Enter>.

The selected file and the merged data is printed  

See the "Data files" chapter for information about
using ElixirView software to view the form merged
with the variable data. 

Quit option

To quit the DataMerge program and return to the DOS
prompt, select the Quit menu and press <Enter>.  
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Figure 5-9.  Quit option

Operating DataMerge in batch mode 

You can operate DataMerge in batch mode from the
DOS command line directly or through the Desktop
Dispatcher.  For information about operating Da-
taMerge from the Dispatcher, see the "DataMerge op-
eration for Windows" chapter.

When you operate DataMerge in batch mode, you can
either specify the parameters in the command line or
you can use the settings in the DM.CFG file.  

Operating DataMerge using parameters 

To operate DataMerge using parameters, type the fol-
lowing at the DOS prompt:

DM [filestemname] [jobfilename] [-optionalparameter] 

filestemname
is the stem name of the .DAT file.

jobfilename
is the job file name including path and stem.
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-optional parameter
is an optional parameter (or parameters) as described
in the "Command line parameters" appendix. 

If you do not specify any optional parameters, or if a
parameter is missing, DataMerge uses the settings in
the DM.CFG file.

Note that if you are using format 1 in your .DAT file,
you must use the [-USENAME] parameter and if you
are using format 3 in your .DAT file, you must use the
[-D:value] parameter (where value is the delimiter
character used in your .DAT file).  See the "Data Files"
chapter for more information about .DAT file formats.

Operating DataMerge using the DM.CFG file

The DM.CFG file contains the settings specified in the
Setup menu described previously.  For information on
changing the setup parameters, see the Setup menu
section in this chapter.

To operate DataMerge using settings in the DM.CFG
file, type the following at the DOS prompt:

DM [filestemname] [-D:value] [-usename] <En-
ter>

filestemname
is the stem name of the .DAT file to be processed. 

-D:value
If you are using format 3 in your .DAT file, you must
use the [-D:value] parameter where value is the delim-
iter character used in your .DAT file.

-usename
If you are using format 1 in your .DAT file, you must
use the [-USENAME] parameter 

See the "Data Files" chapter for more information
about .DAT file formats.

DataMerge looks for the .DAT file in the text directory
specified in the DataMerge configuration file,
(DM.CFG).  You do not have to specify the file exten-
sion of the .DAT file.
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6.  Moving and printing files

This chapter describes how to use several popular file
transfer packages to transfer files between your PC
and a host computer running the IBM MVS operating
system.

Files for printing on channel-attached Xerox produc-
tion or distributed printers can be stored on a host
computer.

When you transfer FSL, FRM or metacode files to the
printer for printing, you must also transfer any .LGO,
.IMG or .FNT files referenced in your documents.
Note that metacode files have the .IMG files embed-
ded.   

FRM, FSL, logo, image, and font files are also re-
ferred to as Xerox-labeled files, because the files con-
tain 128-byte Xerox headers (or labels).

In an off-line environment, tape and Xerox-format
diskettes are used to move files. In an on-line environ-
ment, PC/host file transfer packages are used to
move files. Supported file transfer packages include
the IBM 3270, IRMA FT/3270, and IRMA FT/TSO.

Moving on-line Xerox-labeled files

This section describes procedures for transferring
Xerox-labeled files from a PC (through an IBM host
running MVS) to a production printer.

To upload FSL files, first run the PACK utility on the
files to convert them to Xerox 128-byte format (see
the "Stand-alone utilities" chapter for information on
the PACK utility).

1. Configure one of the supported file transfer
utilities.
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2. Upload the files to the MVS host.

3. Download all files from the host computer to
your production printer using one of the
following methods:

-   the HOSTCOPY utility

-  the DJDE FILE command in the job JSL

The above steps are described in the following
sections.

Configuring the file transfer package

To upload Xerox-labeled files from your PC to an MVS
host, we recommend one of the following file transfer
packages: IBM 3270, IRMA FT/3270, or IRMA
FT/TSO.

Make sure the card for the appropriate file transfer
package is installed on your PC, and that the corre-
sponding file transfer software is installed both on your
PC and on the MVS host.

Uploading files to the host

The following sections describe how to upload Xerox-
labeled files and text files from your PC to an MVS
host using IBM 3270, IRMA FT/3270, and IRMA
FT/TSO.

Uploading Xerox-labeled files with IBM 3270 or
IRMA FT/3270

The IBM 3270 and IRMA FT/3270 file transfer pack-
ages are similar. Both require that you first prepare
the host for receiving Xerox-labeled files by allocating
a data set with the following DCB specifications:

DCB=(LRECL=128,BLKSIZE=128,RECFM=FB)

This specifies a Xerox-labeled file with a record length
of 128 bytes, block length of 128 bytes, and fixed-
block (FB) record format.
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Upload a Xerox-labeled file by typing the following
command at the DOS prompt:

SEND [path]pcfilename 'hostfilename'
<Enter>

path
is the optional DOS pathname

pcfilename
is the name of the Xerox-labeled file on your PC, in-
cluding extension.

hostfilename 
is the host dataset receiving the file (hostfilename
must be enclosed in single quotes). 

'hostfilename' can refer to either a physical sequential
or a partitioned dataset. 

For example, if transferring to a physical sequential
dataset, 'hostfilename' may be as follows:

'CM.EIO.DATA.UPLOAD'

If transferring to a partitioned dataset, 'hostfilename'
can include the stem name of the files being trans-
ferred, enclosed in parentheses, as part of the dataset
name as follows:                      

           'CM.EIO.DATA.UPLOAD(filename)'

Uploading text files with IBM 3270 or IRMA
FT/3270

To upload a text file, first allocate a dataset on your
host with the following DCB parameters:

DCB=(LRECL=255,BLKSIZE=3000,RECFM=VB) 

Add the ASCII and EBCDIC statements to the end of
SEND and RECEIVE commands, respectively, for
.FSL files only.

To send a text file to an MVS host, type the following
command from the DOS prompt.
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SEND [path]pcfilename 'hostfilename' ASCII
<Enter>

This command uploads the Xerox-labeled file pcfile-
name to the host dataset hostfilename. A DOS direc-
tory path before pcfilename is optional. The ASCII
parameter at the end of the command string trans-
lates the file from ASCII to EBCDIC.

Note that to download a text file from the host, you
type the following command:

RECEIVE [path]pcfilename 'hostfilename'
EBCDIC <Enter>

This command downloads the Xerox-labeled file host-
filename to the PC file pcfilename. A DOS directory
path before pcfilename is optional. The EBCDIC pa-
rameter at the end of the command string translates
the file from EBCDIC to ASCII.

Uploading Xerox-labeled files with IRMA FT/TSO

Use the following procedure to upload a Xerox-labeled
file with IRMA FT/TSO:

Type FTTSO <Enter> at the DOS prompt to start the
FTTSO software and display the IRMA FT/TSO
screen.

Figure 6-1.  FT/TSO transfer parameters

Change the file transfer parameters as follows:

1. Use the <Tab> key to move the cursor into the
data entry field following [Transfer type:].
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2. Type a name under which you want to save
Xerox-labeled file transfer parameters
(described in step 4). The example in the
above figure shows XEROX.

3. Press <F5>.

The Transfer Parameters menu displays in the
bottom right corner of the screen.

4. Use the <Tab> key to move between transfer
parameter fields and enter the following
values:
Block size:               128
Record size:             128
Record format:          FB 
Line numbers:          Position: 0 Length: 0
Code table:               STD 
Transfer mode:         BINARY 
Expand TABs:           NO 
Truncate spaces:      NO 
U/L case:                   ASIS 
Space Units:             TRKS 
Primary qty:               1 
Secondary qty:          2

The values above are for transferring Xerox-labeled
files. To transfer text files, you must use different val-
ues for some parameters. Since text files may be
stored on host computers in datasets with different
DCB parameters, you must tailor the transfer parame-
ters to match the text file DCB parameters used at
your site. Listed below are some typical values used
for transferring text files:

Block size: 3000
Record size: 255
Record format: VB 
Line numbers: Position: 0 Length: 0 
Code table: STD 
Transfer mode: TEXT 
Expandtabs: NO 
Truncate spaces: NO 
U/L case: ASIS 
Space units: TRKS 
Primary QTY: 1 
Secondary QTY: 2
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To upload files with IRMA FT/TSO, use the following
procedure:

1. Enter the name of the PC file you want to
upload and press <Tab>.

Optionally, precede the file name with a DOS
directory path.

2. Enter the name of the host dataset to which
you want to upload the file and press <Tab>.

3. Enter the appropriate transfer type for
sending Xerox-labeled files (binary).

4. Press <F1> to upload the file.

Downloading files from the host to the printer

Download files from the host computer to the produc-
tion printer using one of the following methods:

the HOSTCOPY utility

the DJDE FILE command

The following sections describe the two downloading
methods and also compare the differences between
them.

HOSTCOPY and FILE comparison

Using the HOSTCOPY utility involves the following
steps:

1. Make sure that all of the files used in the job
are resident on the printer.

2. Reboot the printer.

3. Download the files using HOSTCOPY.

4. Reboot the printer again.

5. Start the print job.
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Using the FILE command requires that you add the
FILE command to the JSL which will dynamically
download all files at print time.

The advantages of using the FILE command rather
than HOSTCOPY to download files are:

Using the FILE command frees up disk space on
the printer.

As files do not have to be resident on the printer,
an additional level of security can be maintained.

Using the FILE command does not require
switching the printer from production mode to
HOSTCOPY mode and saves valuable printer
time.

As files are downloaded during print time, the cur-
rent and correct versions of the files are used
(when using HOSTCOPY, it is important to check
that all files resident on the printer and used for
the job are the correct versions).

Using the HOSTCOPY utility

To use the HOSTCOPY utility, use the following
procedure:

1. Upload ENDFILE.END.

2. Prepare the appropriate JCL.

3. Place the printer in HOSTCOPY mode.

4. Download the files.

Uploading ENDFILE.END
After uploading Xerox-labeled PC files, upload the
ENDFILE.END file (copied to the drive:\ELIXIR direc-
tory during installation) to the host. Use the procedure
described in the "Uploading with IBM 3270 or IRMA
FT/3270" section of this chapter.
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Preparing JCL
After uploading Xerox-labeled files and the
ENDFILE.END files to the host, use the IBM
IEBGENER utility to build a JCL dataset for sending
the files to a channel-attached 9700 series printer.

An example of a JCL dataset is given below. You
must modify the JCL to include the names of the files
you want to send to the printer.

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
//00D42DA JOB (8200,Z200-Z20001),'LARACEY
7-1994',CLASS=A
//MSGCLASS=J,NOTIFY=00D42D,USER=00D42D,PRTY=4
/* JOBPARM L=9999
//*
//* JCL to send a Xerox-labeled file to a 9700 series printer
//*
//XRX9700 OUTPUT DEST=R269
//*
//* This step copies the file UN110E.FNT
//* to the Xerox printer's output destination
//* class
//*
//STEP1 EXEC PGM=IEBGENER
//SYSPRINT D SYSOUT=*
//SYSUT1 DD UNIT=DISK,DISP=OLD,
//DSN=00D42D.0Z200.UN110E.FNT.DATA,
//DCB=(LRECL=128,BLKSIZE=128,RECFM=FB)
//SYSUT2 DD SYSOUT=O
//*
//* This step copies the ENDFILE.END file
//* to the Xerox printer's output destination
//* class to terminate the HOSTCOPY procedure
//*
//STEP2 EXEC PGM=IEBGENER
//SYSPRINT D SYSOUT=*
//SYSUT1 DD UNIT=DISK,DISP=OLD,
//DSN=00D42D.0Z200.ENDFILE.END.DATA,
//DCB=(LRECL=128,BLKSIZE=128,RECFM=FB)
//SYSUT2 DD SYSOUT=O
//OUTPUT=*.XRX9700
//SYSIN DD DUMMY
//*
- - - - - - - - - - - - - - -- - - - - - - - - - - - - - - - - - - - - - 

Placing the printer in HOSTCOPY mode
To place a channel-attached, production printer in
HOSTCOPY mode, follow these steps:
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1. Switch the printer to OFF-LINE.

The printer status displays OFF-LINE IDLE at the
printer console.

2. Press the printer BOOT switch.

The printer console displays a command menu
with the following system prompt: 

ENTER COMMAND

3. Enter the following command:

HOSTCOPY <Enter>

The following message displays: 

*SYSGEN RUNNING FOR HOSTCOPY ON-
LY*THIS IS A FILE COPYING PROCEDURE,
NOT A SYSGEN CONTINUE OR ABORT? EN-
TER 'C' OR 'A'

4. Enter:

C <Enter>

The printer displays the following message:

WAITING TO READ FILES FROM HOST

The printer is now in HOSTCOPY mode and ready to
accept files from the host.

Copying Xerox-labeled files to the printer
After placing the printer in HOSTCOPY mode, run the
JCL job to send the Xerox-labeled and ENDFILE.END
files to your printer. 

Note that ENDFILE.END must be the last file you
send to the printer. 

The following message displays at the printer console,
indicating that files are being received:

CREATING FILE xxxxxx.yyy

When the printer detects the ENDFILE.END file, the
following message displays:
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END OF TAPE FOUND
IS ANOTHER TAPE TO BE SENT? Y OR N 

If you want to send more files, type Y <Enter>. 

If you are done transferring files, press N <Enter> to
display:

VARY OFFLINE AT HOST, THEN ENTER C

Enter C to stop the copy-to-printer operation.

Reboot the printer.

The Xerox-labeled files are now installed on the pro-
duction printer.

Using the FILE command

This requires that you embed the DJDE FILE com-
mand in the job JSL. The FILE command causes files
to be dynamically downloaded to the printer at print
time. The command syntax is as follows:

FILE=filename, filetype [,[f][,[s][,n]]]]

filename
is a one- to six-character file name.

filetype
is a three character file symbol for the appropriate file;
LGO, IMG, FSL, FNT, or FRM.

f
is C (for card-image format) or L (for tape format, the
default).

s
is D (to delete files after printing) or P (to keep the
files after printing, the default).

n
is the maximum number of card-images (default =
120).

After adding the FILE command to your JSL state-
ments, compile the JSL and START the compiled JDL
at the printer console to run the print job.
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See your Xerox Laser Printing System Reference
Manual for more information.

Moving and printing on-line metacode files

The following section describes how to move and print
on-line metacode files.

Online metacode file format

The fixed blocked on-line metacode file has the fol-
lowing format for each 540 byte block:

Bytes 0 to 3 - Block length (hex).

Bytes 4 to 7 - Length of first metacode record (hex).

Bytes 8 to n - First metacode record, where n is 7
plus the length specified in bytes 4 to 7.

Bytes n +1 to 540 - The remainder of each 540 byte
block consists of a series of four byte record descrip-
tor words followed by a corresponding metacode
record.

The record descriptor words specify the length of each
metacode record.  The end of each 540 byte block
may be padded with hex zeros.

Printing on-line metacode files

To print on-line metacode files produced by
DataMerge:

1. Upload the file to the host.

2. Set up the default on-line JSL on the printer.

3. Set up the Elixir on-line JSL on the printer.

4. Compile the JSL on the printer.

5. Prepare the JCL data set on the host.
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6. Copy the file to your printer. 

Uploading metacode files to the host

To upload metacode files from your PC to an MVS
host, use a file transfer package such as IBM 3270,
IRMA FT/3270, or IRMA FT/TSO.

Make sure the card for the appropriate file transfer
package is installed on your PC, and that the corre-
sponding file transfer software is installed on both your
PC and the MVS host.

Uploading with IBM 3270 or IRMA FT/3270

The IBM 3270 and IRMA FT/3270 file transfer pack-
ages require that you first prepare the host for receiv-
ing metacode files by allocating a data set with the
following DCB specifications:

DCB=(LRECL=540,BLKSIZE=540,RECFM=FB)

This specifies a file with a record length of 540 bytes,
block length of 540 bytes, and fixed-block (FB) record
format.

You then upload a metacode file by typing the follow-
ing command at the DOS prompt:

SEND [path]pcfilename 'hostfilename'
<Enter>

path
is the optional DOS path pcfilename is the name of
the metacode file on your PC, including extension.

hostfilename 
is the host dataset receiving the file (hostfilename
must be enclosed in single quotes). 

'hostfilename' can refer to either a physical sequential
or a partitioned dataset. 

For example, if transferring to a physical sequential
dataset, 'hostfilename' may be as follows:

'CM.EIO.DATA.UPLOAD'
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If transferring to a partitioned dataset, 'hostfilename'
can include the stem name of the files being trans-
ferred, enclosed in parentheses, as part of the dataset
name as follows: 

'CM.EIO.DATA.UPLOAD(filename)'

Uploading with IRMA FT/TSO

Use the following procedure to upload a Xerox-format
file with IRMA FT/TSO:

Type FTTSO <Enter> at the DOS prompt to start the
FT/TSO file transfer software and display the IRMA
FT/TSO screen shown in the previous figure.

Change the file transfer parameters as follows:

1. Use the <Tab> key to move the cursor into the
data entry field following [Transfer type:].

2. Type a name under which you want to save
Xerox-labeled file transfer parameters
(described in step 4). The example in the
previous figure shows XEROX.

3. Press <F5>.

The Transfer Parameters menu displays in the
bottom right corner of the screen.

Use the <Tab> key to move the cursor be-
tween transfer parameter fields and enter the
following values:

Block size: 540 
Record size: 540
Record format: FB 
Line numbers: Position: 0 Length: 0 
Code table: STD  
Transfer mode: BINARY 
Expand TABs: NO  
Truncate spaces: NO
U/L case: ASIS
Space units: TRKS
Primary qty: 1
Secondary qty: 2
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To upload files with IRMA FT/TSO:

1. Enter the name of the PC file you want to
upload and press <Tab>.

Optionally, precede the file name with a DOS
directory path.

2. Enter the name of the host dataset to which
you want to upload and press <Tab>.

3. Enter the appropriate transfer type for
sending Xerox-labeled files (binary).

4. Press <F1> to upload the file.

Setting up on-line default JSL

The following is an example of a default JSL file used
in an ONLINE environment. The default JSL used at
your installation will be different.                                 -
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
DFAULT:JDL
VFU1: VFU ASSIGN=(1,1),TOF=1,BOF=66;
PDEDFT: PDE BEGIN=(1,.5),PMODE=LANDSCAPE, 

FONTS=(LO112B); 
ACCT USER=NONE; 
VOLUME HOST=IBMONL,CODE=EBCDIC;

 IDEN PREFIX=`$DJDE$',SKIP=10,  
OFFSET=1,OPRINFO=NO; 

RECORDLENGTH=200;
TBAN1:TABLE CON=(`START JOB',`START STC',`START TSU');
TBAN2: TABLE CON=(`END JOB'; `END STC';`END TSU');
CBAN1: CRITERIA CONSTANT=(3,9,EQ,TBAN1);
CBAN2: CRITERIA CONSTANT=(4,8,EQ,TBAN2);
RAXT:    TABLE CONSTANT=X`1111111111111111';
ROFT: TABLE CONSTANT=X`1212121212121212'; 
RSTK: TABLE CONSTANT=X`1313131313131313'; 
RAX: CRITERIA CONSTANT=(1,8,EQ,RAXT); 
ROF: CRITERIA CONSTANT=(1,8,EQ,ROFT); 
RST: CRITERIA CONSTANT=(1,8,EQ,RSTK);  

RSTACK TEST=RST,DELIMITER=YES;
  BANNER 
TEST=(CBAN1,OR,CBAN2),HCOUNT=1, 
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TOUNT=1, HJOBNO=(13,4);
 LINE DATA=(0,400),VFU=VFU1,FCB=IGNORE, 

UCSB=IGNORE,FONTINDEX=(0,ZERO);

OUTPUT GRAPHICS=YES,PURGE=YES, 
OFFSET=NONE,

 DUPLEX=YES,FORMAT=PDEDFT;
DFLT: JDE;
END; 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

Note that for printing on HighLight color printers, copy
the following lines from the ELIXIC.JSL (supplied with
DataMerge and written to drive:\ELIXIR during instal-
lation) to your default JSL. ELIXIC.JSL is listed in the
"Moving and printing offline metacode" section of this
chapter.

Add the following lines after line 2 of your default
JSL: 

RED1: IDR ICATALOG=XEROX, 
PALETTE='PICTORIAL', 
ILIST = ('BLACK','RED');  

BLUE1: IDR ICATALOG=XEROX, 
PALETTE='PICTORIAL', 
ILIST = ('BLACK','BLUE');  

GREEN1: IDR ICATALOG=XEROX, 
PALETTE='PICTORIAL', 
ILIST = ('BLACK','GREEN'); 

Add the following lines after the DFLT: JDE;
statement and before the END statement of your
default JSL:

RED: JOB;
          OUTPUT IDR=RED1,IRESULT=BLACK;
 ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE,            ISUBSTITUTE=ANY; 
BLUE: JOB;
          OUTPUT IDR=BLUE1,IRESULT=BLACK;
 ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE,        ISUBSTITUTE=ANY; 
GREEN: JOB; 
           OUTPUT IDR=GREEN1,IRESULT=BLACK; 
ABNORMAL ERROR=CONTINUE, IMISMATCH=CON-
TINUE,         ISUBSTITUTE=ANY; 
RLEG: JOB;
          OUTPUT IDR=RED1, IRESULT=BLACK,

PAPERSIZE=USLEGAL;          
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ABNORMAL ERROR=CONTINUE,IMISMATCH=CONTINUE,
ISUBSTITUTE=ANY

BLEG: JOB;
           OUTPUT IDR=RED1, IRESULT=BLACK,

    PAPERSIZE=USLEGAL;
 ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
GLEG: JOB;
           OUTPUT IDR=RED1, IRESULT=BLACK,

PAPERSIZE=USLEGAL;
 ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
RA4: JOB;
           OUTPUT IDR=RED1, IRESULT=BLACK,

PAPERSIZE=A4;
 ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
BA4: JOB;
           OUTPUT IDR=RED1, IRESULT=BLACK,

     PAPERSIZE=A4;
 ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
GA4:JOB;
           OUTPUT IDR=RED1, IRESULT=BLACK,

PAPERSIZE=A4;
 ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY

You would not normally change the default JSL file on
your printer unless you want to print a color metacode
file or one that contains an image (.IMG file). 

Make sure that the following statements are correctly
specified in your default JSL:

JDL on the first line must be the same name as
the compiled default JSL currently on your printer.

CODE=EBCDIC

PREFIX='$DJDE$'

OFFSET=a, SKIP=b (see explanation below)

To print .IMG files:

Specify GRAPHICS = YES in the OUTPUT
statement
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Ensure that a graphics handling option is installed
on your printer.

Set OFFSET and SKIP to the values specified in the
default JSL on your printer (shown as 1 and 10 in the
default JSL example described later in this section).
OFFSET is the leading number of space characters
before the $DJDE$ prefix string. SKIP is the total
number of characters specified before the beginning
of DJDE control characters, including leading spaces.

For example, if PREFIX = $DJDE$, SKIP=10, and
OFFSET=1, specify the $DJDE$ prefix string in the
Setup menu as follows:

b$DJDE$bbb

where each b is one space character.

Preparing on-line ELIXIR.JSL

The ELIXIR.ONL file listed below is supplied with Da-
taMerge and is copied to the drive:\ELIXIR directory
during installation. This file and the default on-line JDL
file, format the on-line metacode printout. 

ELIXIR.ONL

The following shows a listing of the ELIXIR.ONL file: 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
-
ELIXIR: JDL
VFELX: VFU ASSIGN=(1,1),ASSIGN=(12,255),TOF=1, 

BOF=255;
PDELX: PDE BEGIN=(0,0),PMODE=POR, 

FONTS=(UN104B);
RAXT: TABLE CONSTANT=X`1111111111111111';
ROFT: TABLE CONSTANT=X`1212121212121212'; 
RSTK: TABLE CONSTANT=X`1313131313131313'; 
RAX: CRITERIA CONSTANT=(1,8,EQ,RAXT); 
ROF: CRITERIA CONSTANT=(1,8,EQ,ROFT); 
RST: CRITERIA CONSTANT=(1,8,EQ,RSTK);   

VOLUME HOST=IBMONL,LABEL=NONE, 
CODE=NONE;  

LINE DATA=(0,400),VFU=VFELX, 
PCCTYPE=IBM3211,OVERPRINT=PRINT, 
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MARGIN=0,FCB=IGNORE;  
OUTPUT GRAPHICS=YES,PURGE=YES, 

OFFSET=NONE,
DUPLEX=YES,FORMAT=PDELX;

 ACCT USER=NONE; 
RAUX TEST=RAX; 
ROFFSET TEST=ROF; 
RSTACK TEST=RST,DELIMITER=YES;

 IDEN PREFIX=X`5BC4D1C4C55B',SKIP=10,  
OFFSET=1,OPRINFO=NO;

  RECORD LENGTH=1032; 
DFLT: JDE; 
END; 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

Note that for printing on HighLight color printers, add
the following lines to your default JSL after the DFLT:
JDE; statement and before the END statement:

RED: JOB;
          OUTPUT IDR=RED1,IRESULT=BLACK;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE,            ISUBSTITUTE=ANY; 
BLUE: JOB;
          OUTPUT IDR=BLUE1,IRESULT=BLACK;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE,        ISUBSTITUTE=ANY; 
GREEN: JOB; 
           OUTPUT IDR=GREEN1,IRESULT=BLACK;            
          ABNORMAL ERROR=CONTINUE, IMISMATCH=CON-
TINUE,         ISUBSTITUTE=ANY; 
RLEG: JOB;
          OUTPUT IDR=RED1, IRESULT=BLACK,

PAPERSIZE=USLEGAL;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
BLEG: JOB;
           OUTPUT IDR=RED1, IRESULT=BLACK,

    PAPERSIZE=USLEGAL;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
GLEG: JOB;
           OUTPUT IDR=RED1, IRESULT=BLACK,

PAPERSIZE=USLEGAL;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
RA4: JOB;
           OUTPUT IDR=RED1, IRESULT=BLACK,

PAPERSIZE=A4;
          ABNORMAL
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ERROR=CONTINUE,IMISMATCH=CONTINUE, ISUB-
STITUTE=ANY
BA4: JOB;
           OUTPUT IDR=RED1, IRESULT=BLACK,

     PAPERSIZE=A4;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
GA4:JOB;
           OUTPUT IDR=RED1, IRESULT=BLACK,

PAPERSIZE=A4;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY

Make sure that the following statements are correctly
specified in ELIXIR.ONL:

JDL on the first line must be ELIXIR

HOST=IBMONL

CODE=NONE

DATA=(0,N) (where N is 200 or greater and
equals the value specified in the default JSL)

PREFIX=X`5BC4D1C4C55B' (see below)

OFFSET=a, SKIP=b (see below)

GRAPHICS=YES (if a graphics handling option is
installed and .IMG files are used - otherwise,
NONE).

Initially, the IDEN statement in the ELIXIR.ONL file
contains the following values:

PREFIX=X'5BC4D1C4C55B'
OFFSET=1
SKIP=10

Modify the above values as described below:

PREFIX is the EBCDIC hexadecimal representation of
the PREFIX parameter specified for IDEN in the de-
fault online JCL file (shown as $DJDE$ in the default
online JCL listing). The value specified for the PRE-
FIX= statement in your default JSL file must be speci-
fied in EBCDIC hexadecimal notation.
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Set OFFSET and SKIP to the values specified in the
default JSL on your printer (shown as 1 and 10 in the
default JSL example). OFFSET is the leading number
of space characters before the $DJDE$ Prefix string.
SKIP is the total number of characters specified be-
fore the beginning of DJDE control characters, includ-
ing leading spaces.

For example, if PREFIX = $DJDE$, SKIP=10, and
OFFSET=1, specify the $DJDE$ Prefix String in the
Setup menu as follows:

b$DJDE$bbb

where each b is one space character.

Edit the ELIXIR.ONL using any ASCII editor on your
PC or on the printer.

Rename the modified ELIXIR.ONL file to ELIXIR.JSL
and compile the modified file on your printer.  Note
that compiled files have .JDL extensions.

Copying metacode files to the printer

To print metacode files, place the printer online and
run the JCL job for copying files from your host to the
printer. An example of a JCL file is as follows:

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
//00D42DA JOB (8200,Z200-Z20001),`LARACEY
7-1994',CLASS=A,
//MSGCLASS=J,NOTIFY=00D42D,USER=00D42D,PRTY=4
/* JOBPARM L=9999
//*
//* JCL TO SEND ELIXIR ONLINE METACODE TO 9790 AND
9700
//*
//XRX9700 OUTPUT DEST=R269
//STEP1 EXEC PGM=IEBGENER
//SYSPRINT DD SYSOUT=*
//SYSUT1DDUNIT=DISK,DISP=OLD,
//DSN=O0D42D.0Z200.IM5816.MET.DATA,
//DCB=(LRECL=536,BLKSIZE=540,RECFM=VBM)
//SYSUT2 DD SYSOUT=O,
// OUTPUT=*.XRX9700
//SYSIN DD DUMMY
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//*
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

Note that the fixed block file created by DataMerge
contains nearly all the attributes of a variable-blocked
machine (VBM) file. However, in an IBM MVS host en-
vironment, the metacode file must be converted to
VBM format by coding the DCB parameter for the in-
put (SYSUT1) file as follows:

DCB=(LRECL=536, BLKSIZE=540, RECFM=VBM). 

Note also that the VBM format requires the record
length to be four bytes less than the block size.

Specifying the DCB parameters, as described previ-
ously, causes the MVS system catalog to view the on-
line metacode dataset as a VBM file instead of an FB
file, which was the record format specified when the
file was uploaded.  The IEBGENER utility then treats
the dataset as a VBM file, and sends each variable
length record within the file down the channel to the
printer.  

Note that online metacode can be delivered to printers
attached to host computers with operating environ-
ments other than MVS.  It is up to the user to deter-
mine the correct upload procedure for their
environment, as well as a means of delivering the
metacode records to the printer.

In VM and DOS environments, you will have to write
your own EXEC or equivalent utility to extract each
variable length metacode record from the 540 byte
blocks of metacode records contained within the on-
line metacode dataset.  

Using tape to move files

Set the [Output to:] option in the Setup menu to TAPE
and run DataMerge. Metacode generated by Da-
taMerge is written to tape.

Modify the ELIXIR.JSL ASCII file in your drive:\ELIXIR
directory as follows:

Set the IDEN PREFIX statement in ELIXIR.JSL to
match the PREFIX string used for Dynamic Job
Descriptor Entries (DJDEs) at your site.
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The DFAULT.JSL and ELIXIR.ONL files must be first
loaded and compiled on your printer.

Mount the tape and type one of the following com-
mands followed by <Enter> at the console:

 Command  to print...

STA RED,DFAULT  letter size using red
toner

STA
GREEN,DFAULT

 letter size using
green toner

STA BLUE,DFAULT  letter size using blue
toner

STA RLEG,DFAULT  legal size using red
toner

STA GLEG,DFAULT  legal size using green
toner

STA BLEG,DFAULT  legal size using blue
toner

STA RA4,DFAULT  A4 size using red
tone

STA GA4,DFAULT  A4 size using green
tone

STA BA4,DFAULT  A4 size using blue
tone

To print online black-and-white metacode, enter the
following command:

STA DFLT,DFAULT <Enter>

Note also that when changing paper sizes, you must
perform a SYSGEN on the printer to support the ap-
propriate paper size.
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Printing offline Xerox-labeled files

This section describes how to move and print FSL,
FRM, and other Xerox-labeled files using tape and
diskettes.

Using diskettes to move files

To print offline files created by DataMerge on your PC
hard disk, use ElixiDisk to copy the files to a Xerox
centralized format diskette, then copy the diskette files
to the printer hard disk. Print the files as described in
the section, "Printing FRM files". Refer to the "Utilities"
chapter for further information about ElixiDisk.

Using tape to move files

To print offline FRM, FSL, and other Xerox-labeled
files written to tape by DataMerge, follow these steps:

1. Set the [Output to:] option in the Meta Options
dialog box to TAPE and run DataMerge.

If you have already created offline files on your
disk drive, use the DSK2TAP utility (supplied with
DataMerge) to copy the disk files to tape. Refer to
the "Utilities" chapter for further information about
DSK2TAP.

2. Make sure you have the compiled ELIXIR.JSL
and ELIX2.JSL offline control files on the
printer.

3. Mount the tape containing the files.

4. At the console, type:

COP TAP REA LAB ALL <Return>

5. Compile FSL files, if any.

6. Print the files.
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Offline control files

The ELIXIR.JSL and ELIX2.JSL files are supplied with
DataMerge and are copied to the drive:\ELIXIR direc-
tory during installation. The files are in ASCII format to
enable you to edit them, if required.

Make sure you compile ELIXIR.JSL and ELIX2.JSL
after copying them to your printer (the compiled files
have .JDL extensions).

Mounting the tape

Mount the tape containing the Xerox-labeled files and
type the following command to copy all files from tape
to the printer disk:

COP TAP REA LAB ALL <Enter>

Compiling FSL files

If you are printing.FSL files, compile them into FRM
format on your printer (or use the ElixiSys Desktop to
convert FSL files to FRM format on your PC). 

Printing FRM files

To print FRM files, first load the Xerox printer com-
mand files (.CMD and .MSC), created by DataMerge
for each FRM file, on the printer.

Note that each Xerox printer command file stem name
is derived from the print file you convert according to
the following rules:

For print file names with six or more characters
(excluding the extension), the stem name con-
sists of the first (left) six characters.

For print file names with less than six characters
(excluding the extension), the stem name con-
sists of all the characters of the file name. 

After loading Xerox printer command files on the
printer, print FRM files by entering the following at the
printer console:

@xxxxxx
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where xxxxxx is the stem name (file name without ex-
tension) of the Xerox printer command files created by
DataMerge. 

Moving and printing offline metacode

This section describes how to move and print offline
metacode files using tape.

Preparing offline ELIXIC.JSL

The ELIXIC.JSL file listed below is supplied with Da-
taMerge and is copied to drive:\ELIXIR during
installation.

The ELIXIC.JSL file is required for printing offline
metacode with highlight colors on HighLight color
printer.

ELIXIC.JSL

The following pages list the ELIXIC.JSL file, required
for printing offline color metacode on Xerox HighLight
color printers:

ELIXIR: SYSTEM; 
PCCXPS:       PCC        
INITIAL=TOF,DEFAULT=(IGN,PSP0),       
ASSIGN=(X'31',IGN,SK1PSPO);
VFXPS1:       VFU        ASSIGN=(1,1),TOF=1,BOF=255; 
PDFLT:        PDE BEGIN=(0,0),PMODE=POR,FONTS=(UN104B);
   RED1: IDR ICATALOG=XEROX,
        PALETTE='PICTORIAL', 
                      ILIST = ('BLACK','RED');  
   BLUE1: IDR ICATALOG=XEROX,
        PALETTE='PICTORIAL',
                       ILIST = ('BLACK','BLUE');  
GREEN1: IDR ICATALOG=XEROX,
         PALETTE='PICTORIAL',
                        ILIST = ('BLACK','GREEN'); 
RAXT: TABLE CONSTANT=X'1111111111111111';
ROFT: TABLE CONSTANT=X'1212121212121212';
RSTK: TABLE CONSTANT=X'1313131313131313'; 
RT: TABLE CONSTANT=A'$RAUX$'; 
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RAX: CRITERIA CONSTANT=(1,8,EQ,RAXT); 
ROF: CRITERIA CONSTANT=(1,8,EQ,ROFT); 
RST: CRITERIA CONSTANT=(1,8,EQ,RSTK); 
RC: CRITERIA CONSTANT=(1,6,EQ,RT); VOLUME 

HOST=IBMOS,LABEL=NONE,CODE=NONE;
LINE   

DATA=(1,400),VFU=VFXPS1,PCCTYPE=PCCXPS,
           OVERPRINT=PRINT,MARGIN=0;
               OUTPUT GRAPHICS=YES,PURGE=YES,

            DUPLEX=YES,FORMAT=PDFLT;
                ACCT USER=NONE;
                RAUX TEST=RAX;
                ROFFSET TEST=ROF;
                RDELETE TEST=ROF;
                IDENPREFIX=(X'2024444A444524202020'),OFFSET=1,

SKIP=10, OPRINFO=NO;
 BLOCK LENGTH=1032,OFFSET=0,LTHFLD=2,

PREAMBLE=4;
 RECORDSTRUCTURE=VB,LENGTH=1028,LTHFLD=2,

PREAMBLE=4;
DFLT: JDE; 
RED: JOB;
          OUTPUT IDR=RED1,IRESULT=BLACK;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE,            ISUBSTITUTE=ANY; 
BLUE: JOB;
          OUTPUT IDR=BLUE1,IRESULT=BLACK;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE,        ISUBSTITUTE=ANY; 
GREEN: JOB; 
           OUTPUT IDR=GREEN1,IRESULT=BLACK;            
          ABNORMAL ERROR=CONTINUE, IMISMATCH=CON-
TINUE,         ISUBSTITUTE=ANY; 
RLEG: JOB;
          OUTPUT IDR=RED1, IRESULT=BLACK,

PAPERSIZE=USLEGAL;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
BLEG: JOB;
           OUTPUT IDR=BLUE1, IRESULT=BLACK,

    PAPERSIZE=USLEGAL;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
GLEG: JOB;
           OUTPUT IDR=GREEN1, IRESULT=BLACK,

PAPERSIZE=USLEGAL;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
RA4: JOB;
           OUTPUT IDR=RED1, IRESULT=BLACK,
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PAPERSIZE=A4;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
BA4: JOB;
           OUTPUT IDR=BLUE1, IRESULT=BLACK,

     PAPERSIZE=A4;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
GA4:JOB;
           OUTPUT IDR=GREEN1, IRESULT=BLACK,

PAPERSIZE=A4;
          ABNORMAL ERROR=CONTINUE,IMISMATCH=CON-
TINUE, ISUBSTITUTE=ANY
END;
------------------------------------------------------------------------------------------

Using tape to move files

Set the [Output to:] option to TAPE and run Da-
taMerge. Metacode generated by DataMerge is writ-
ten to tape.

Modify the ELIXIR.JSL ASCII file in your drive:\ELIXIR
directory as follows:

Set the IDEN PREFIX statement in ELIXIR.JSL to
match the PREFIX string used for Dynamic Job
Descriptor Entries (DJDEs) at your site.

The value you specify for the $DJDE$ Prefix
String option must also match this value.

The DFAULT.JSL and ELIXIR.ONL files must be first
loaded and compiled on your printer.

Mount the tape and type one of the following com-
mands followed by <Enter> at the console:
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 Command  to print...

STA RED,ELIXIR  letter size using red
toner

STA
GREEN,ELIXIR

 letter size using
green toner

STA BLUE,ELIXIR  letter size using blue
toner

STA RLEG,ELIXIR  legal size using red
toner

STA GLEG,ELIXIR  legal size using green
toner

STA BLEG,ELIXIR  legal size using blue
toner

STA RA4,ELIXIR  A4 size using red
tone

STA GA4,ELIXIR  A4 size using green
tone

STA BA4,ELIXIR  A4 size using blue
tone

To print offline black-and-white metacode, enter the
following command:

STA DFLT,ELIXIR <Enter>

Note also that when changing paper sizes, you must
perform a SYSGEN on the printer to support the ap-
propriate paper size.
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Uploading with 871

Use the following procedure to upload a Xerox-format
file with an 871 device. The MET2871 utility reformats
metacode files for correct processing through an 871
device that connects a Xerox mainframe computer
and printer. 

MET2871 filename <Enter>

filename
is the full pathname of the file you want to upload in-
cluding the extension.

Issue the command from the directory in which
MET2871 is located (drive:\ELIXIR). 

DataWare card PC to printer interface

The DataWare PC interface card connects a PC di-
rectly to a Xerox production printer using bus and tag
connectors.

The DataWare PC interface card allows you to send
online metacode files and Xerox files with 128-byte
header records generated by Elixir software to your
Xerox printer.

DataWare CONFIG.SYS device drivers

To use the DataWare card, add the following device
driver in your PC CONFIG.SYS file.

DEVICE=CHANNEL.SYS unit address

unit
is the DataWare I/O port you are using (0 - 3), nor-
mally 0.

address
is the hexadecimal value of the address of the printer
on the I/O channel (between 0 and FE), normally 0F.
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Make sure you specify the full DOS pathname for
CHANNEL.SYS in your CONFIG.SYS file (for exam-
ple, C:\DATAWARE\CHANNEL.SYS 0 0F).

For proper DataWare card operation, other parame-
ters may be required in the CONFIG.SYS file. For de-
tails, see your DataWare documentation.

Copying files to the printer

To copy files to the printer through the DataWare
card, type:

COPY /B [ path] filename ;CHAN <Enter>

filename
can be any Elixir-generated online metacode file or a
Xerox file with a 128-byte header record. 

path
is the optional fully-qualified DOS directory search
path for filename.

Copying online metacode files to the printer

If you copy online metacode files to the printer, make
sure your default and ELIXIR.JSL files are coded
properly. The printer should be online and waiting to
receive data before you begin the copy operation. For
details on configuring your printer in an online environ-
ment, see your Xerox production printer reference
manual.

Copying Xerox 128-byte header files to the printer

If you copy a 128-byte header file to the printer, make
sure the printer is in HOSTCOPY mode before you
begin the copy operation. For further details on the
HOSTCOPY mode, see your Xerox production printer
reference manual.
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7.  Stand-alone utilities

This chapter describes the Elixir stand-alone batch
utilities provided with the DataMerge. These utilities
are copied to the drive:\ELIXIR directory during instal-
lation (drive: is the drive on which you install
DataMerge).

Each time you install or reinstall Elixir software, exist-
ing utilities are overwritten with new ones. If you want
to keep older versions of the utilities, back up the
.EXE and .COM files in your drive:\ELIXIR directory
before installation.  

Using the utilities

The parameters required to run each utility display on
your screen when you enter only the utility name from
the drive:\ELIXIR directory.

Most of the utilities accept DOS wildcard characters
(see your DOS documentation for instructions on the
proper use of wildcards). When using wildcards, spec-
ify only the desired file or files. 

For optional utility parameters enclosed in brackets [],
enter the appropriate parameters for the option as de-
scribed in the Usage section of the utility, or leave
them blank if you want to use the default (the default
is listed first in the list following the parameter). 

When specifying utilities, either do not specify pa-
rameters (to use the default for each parameter) or
specify all the parameters. You cannot skip
parameters.

All utilities are tied into Elixir Desktop operations
through dialog boxes (although not all utility options
are available from the Desktop dialog boxes).
Application-specific utilities must be run on the
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command line using the DOS pull-down menu or the
Dispatcher icon. See the "Accessing DOS files and
applications" chapter in your ElixiSys Desktop User
Guide for more information.

ElixiDisk

Elixir supports the following standard transfer options:

host upload/download 

tape transfer

direct PC-to-printer connection via a channel card
or SPUR device

For users with compatible PCs, the ElixiDisk utilities
provide an additional option. If the ElixiDisk utilities are
not supported by your PC (see the conditions listed on
the next page), use one of the standard transfer op-
tions listed above.

ElixiDisk consists of the XCPY, XDEL, XDIR, and
XFORMAT utilities. These utilities perform the
following:

display directory information about Xerox-format
diskettes 

format diskettes for use on a production printer

copy files between Xerox-format diskettes and
the hard drive on your PC

delete files from Xerox-format diskettes.

You can format only low-density 5.25-inch diskettes to
Xerox-format. (All production printer floppy formats
except for the 4075 printer format are supported. No
distributed printer floppy formats are supported.)

ElixiDisk runs on most IBM and compatible PCs with
the following conditions: 
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ElixiDisk utilities that read and write floppy disk-
ettes used for carrying data to and from the x9700
printers function on most compatible PCs. Elixi-
Disk utilities may not function on PCs with moth-
erboard BIOS chips that contain implementations
that prohibit operation, however. 

ElixiDisk operates with any Xerox standard format
file, that is, one divided into 512-byte blocks with
or without tape headers.

ElixiDisk is not compatible with the ROM BIOS on
some PCs (for example, the Compaq DeskPro),
and may not operate correctly if the ROM BIOS
on your PC is dated 1987 or earlier. Use a PC
utility program (such as Norton Utilities) to check
your BIOS date.

External disk drives are not supported.

ElixiDisk utilities may not be supported by the IBM
PS/2. PS/2 users can copy files to the host using a
supported PC-to-mainframe communications
package.

ElixiDisk utilities are provided as originally packaged,
and may not run with all PCs or configurations due to
manufacturer changes in initial hardware or software.
Elixir continues to provide support for ElixiDisk utilities
but cannot guarantee their operation with all systems
and configurations.

XDIR

XDIR displays a directory of files for Xerox 4XXX,
87XX, or 97XX diskettes. 

Usage XDIR drive:[filename]

drive 
is the diskette drive specification (A: or B:) 

filename 
is any six-character file name with a three-character
extension. Wildcards are allowed. 
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Directory
information Run XDIR from the drive:\ELIXIR directory if you have

not specified drive:\ELIXIR in a DOS PATH= state-
ment.

Example 1 To display a list of all files with .FNT extensions on a
Xerox-format diskette, type the following commands
from drive: 

CD \ELIXIR <Enter>

The current directory changes to drive:\ELIXIR.

XDIR A: *.FNT <Enter>

XDIR displays all files on your Xerox-format diskette
with .FNT extensions.

Example 2 To display a list of all files on a Xerox-format diskette,
from drive:, type: 

CD \ELIXIR <Enter>

The current directory changes to drive:\ELIXIR.

XDIR A: <Enter>

XDIR displays a list of all the files on your Xerox- for-
mat diskette.

XFORMAT

XFORMAT formats any low-density DOS diskette into
Xerox XXX, 87XX, or 97XX format.

Usage XFORMAT drive: <Enter>

drive: 
is the drive specification (a: or b:).

Directory 
   information Run XFORMAT from the drive:\ELIXIR directory if you

have not specified drive:\ELIXIR in your DOS PATH=
statement.

Example To format a low-density diskette in drive A: into Xerox
format, type:
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XFORMAT A: <Enter>

ElixiDisk utilities are provided as originally packaged,
and may not run with all PCs or configurations due to
manufacturer changes in initial hardware or software.
Elixir continues to provide support for ElixiDisk utilities
but cannot guarantee their operation with all systems
and configurations.

XCPY

The XCPY command allows you to:

copy Xerox standard format files from your PC
hard disk to a Xerox format diskette

copy Xerox standard format files from Xerox for-
mat diskettes to your PC hard disk.

Copying from hard disk to Xerox-format diskette

Use XCPY to copy Xerox standard format files from a
PC hard disk to a Xerox-format diskette.

Usage  XCPY [drive1: ] [path1] filename drive2:
<Enter>

drive1:
is the source drive. If not specified, the DOS drive
from which you run XCPY is considered the default
source drive and is the drive on which XCPY searches
for files.

path1:
is the optional DOS directory path that indicates the
location on drive1: in which files specified by filename
are located. When writing files from your hard disk to
a Xerox-format diskette, XCPY searches the Elixir de-
fault directories for a file if path1 is not specified. The
following are Elixir default directories for the resource
types indicated:

Fonts (FNT) drive:\ELIXIR\FONTS\X97OUT
Forms (FRM) drive:\ELIXIR\FORMS\FRMOUT
Forms (FSL) drive:\ELIXIR\FORMS\FSLOUT
Logos (LGO) drive:\ELIXIR\PICS\LGOOUT
Images (IMG) drive:\ELIXIR\PICS\IMGOUT
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To write 5Word format fonts to a Xerox-format disk-
ette, you must specify the full path to the output direc-
tory: drive:\ELIXIR\FONTS\FN6OUT.

XCPY searches for all other Xerox file types (such as
.MSC) in the directory and drive from which XCPY is
invoked.

filename
is any six-character file name and three-character ex-
tension production printers recognize, such as .FNT,
.LGO, .FSL, .FRM, and .MSC. Wildcards are allowed,
except in file name extensions.

drive2
is the destination drive, and must be specified.

Note: drive1: can be any drive specification between
A: and Z:; drive2: must be either A: or B:.

Directory 
information Run XCPY from the drive:\ELIXIR directory if you

have not specified drive:\ELIXIR in a DOS PATH=
statement.

Example 1 To copy all files with .FNT extensions from the
drive:\ELIXIR\FONTS\ directory to a Xerox-format
diskette in the B: drive, from drive:, type:

XCPY \ELIXIR\FONTS\X97OUT\*.FNT B:
<Enter>

XCPY copies all files with .FNT extensions in the
drive:\ELIXIR\FONTS\ directory to the Xerox-format
diskette in the B: drive.

Example 2 To copy FORM1.FRM from your PC to a Xerox-format
diskette in the A: drive, type:

XCPY FORM1.FRM A: <Enter>

XCPY searches the default directory for .FRM format
files, and the drive:\ELIXIR\FORMS\FRMOUT direc-
tory for the FORM1.FRM file. It then copies the file to
the Xerox-format diskette in the A: drive.

STAND-ALONE UTILITIES
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Copying from Xerox-format diskette to hard disk

Usage XCPY [drive1:]filename drive2:[path2]<Enter>

drive1
is the source diskette drive.

filename
is any six-character file name and three-character ex-
tension production printers recognize, such as .FNT,
.LGO, .FSL, .FRM, and .MSC. Wildcards are allowed,
except in file extensions.

drive2
is the destination drive, and must be specified.

drive2 can be any drive specification between A: and
Z:; drive1 must be either A: or B:.

path2
can be specified when copying files from a Xerox-
format diskette to your hard drive. If you do not specify
path2, the following Elixir default directories are used
for each indicated file type:

Fonts (FNT) drive:\ELIXIR\FONTS\X97IN
Forms (FRM) drive:\ELIXIR\FORMS\FRMIN
Forms (FSL) drive:\ELIXIR\FORMS\FSLIN
Logos (LGO) drive:\ELIXIR\PICS\LGOIN
Images (IMG) drive:\ELIXIR\PICS\IMGIN

To copy 5Word format fonts to your PC, you must
specify the full path to the input
directory:drive:\ELIXIR\FONTS\FN6IN.

All other Xerox file types (such .MSC) are placed in
the directory and drive from which XCPY is invoked.

Directory 
information Run XCPY from the drive:\ELIXIR directory if you

have not specified drive:\ELIXIR in your DOS PATH=
statement.

Example 1 To copy all files with .FNT extensions from a Xerox-
format diskette in the B: drive to the \FONTS\PROD-
FONT directory on your D: drive, type:
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XCPY B:*.FNT D:\FONTS\PRODFONT
<Enter>

Example 2 To copy FORM1.FRM from a Xerox format diskette in
the A: drive to the .FRM format input forms directory
on your C: drive, type:

XCPY A: FORM1.FRM C:<Enter>

XCPY copies FORM1.FRM from the Xerox-format
diskette in the A: drive to the default .FRM forms input
directory (C:\ELIXIR\FORMS\FRMIN).

ElixiDisk utilities are provided as originally packaged,
and may not run with all PCs or configurations due to
manufacturer changes in initial hardware or software.
Elixir continues to provide support for ElixiDisk utilities
but cannot guarantee their operation with all systems
and configurations.

XDEL

The XDEL command deletes files on a Xerox 4XXX,
87XX, or 97XX diskette.
 

Usage XDEL drive:\filename <Enter>

drive
is the diskette drive specification (A: or B:).

filename
is any six-character file name and three character ex-
tension. Wildcards are allowed. 

Directory 
information Run XDEL from the drive:\ELIXIR directory if you have

not specified drive:\ELIXIR in your DOS PATH= state-
ment.

Example To delete all files with .LGO extensions on a Xerox-
format diskette in drive A:, type:

XDEL A: *.LGO <Enter>

XDEL deletes all files with .LGO extensions on the
Xerox format diskette in the A: drive.

STAND-ALONE UTILITIES
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ElixiDisk utilities are provided as originally packaged,
and may not run with all PCs or configurations due to
manufacturer changes in initial hardware or software.
Elixir continues to provide support for ElixiDisk utilities
but cannot guarantee their operation with all systems
and configurations.

DISP

The DISP utility displays the contents of a file on your
screen in hexadecimal, ASCII, and screen character
format.  This information is helpful for debugging files.

Usage DISP filename [count][pausing] <Enter>

filename
is any file name, including path and extension.

count
is the number of characters displayed per line.  The
default is 15.

pausing
specify whether or not to pause after displaying a
screen of data: PAUSE or NOPAUSE. 

Directory
information Run DISP from the drive:\ELIXIR directory, if you have

not specified drive:\ELIXIR in your DOS PATH=
statement.

Example To display the contents of the file NEW.FNT in the
drive:\ELIXIR\FONTS\X97OUT directory, type:

CD \ELIXIR <Enter>

The current directory changes to \ELIXIR.

DISPdrive:\ELIXIR\FONTS\X97OUT\NEW.FNT
<Enter>

The contents of NEW.FNT displays.

STAND-ALONE UTILITIES
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DSK2TAP

DSK2TAP copies files from the PC hard disk or disk-
ette drive to an attached tape drive unit. Elixir supports
tape drive units that use the Overland tape controller.
The Qualstar 9 track 1600 or 6250 bpi model is rec-
ommended. Make sure the appropriate hardware and
software is installed on your PC.

DSK2TAP always creates files with 128-byte headers,
except metacode files, which do not have headers.

Usage DSK2TAP filename <Enter>

filename
is any DOS file name, including the file extension.
Wildcards are allowed.

Directory
information Run DSK2TAP from the directory in which files to be

copied reside, and precede the DSK2TAP command
with drive:\ELIXIR\. (The full command is
drive:\ELIXIR\DSK2TAP filename if you have not
specified drive:\ELIXIR in your DOS PATH=
statement).

Example 1 To copy all files named FORM1 located in the
drive:\ELIXIR\FORMS\FRMOUT directory of the hard
disk to the tape drive, type:

CD \ELIXIR\FORMS\FRMOUT <Enter>

The current directory changes to
drive:\ELIXIR\FORMS\FRMOUT.

drive:\ELIXIR\DSK2TAP FORM1.*
<Enter>

DSK2TAP copies all files with the stem name
FORM1 to tape.

Example 2 To copy fonts from the \FONTS directory to a diskette
in your A: drive, type:

CD \FONTS  <Enter>

The current directory changes to \FONTS.
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drive:\ELIXIR\DSK2TAP *.FNT A:
<Enter>

This copies all .FNT files from the current direc-
tory to the diskette in the A: drive.

FORMCVT

The FORMCVT utility converts form and XES files be-
tween the following formats: 4075FRM, 4075FSL,
9700FRM, 9700FSL, COLORFRM, COLORFSL, XES,
Elixir, 4050FRM, and 4050FSL.

Usage FORMCVT stemname [inputformat]
[output format] [papersize] [fonts]
[confirm] [output device]
[palette][monitor]<Enter>

stemname
is the stem name of the files for conversion.  Exten-
sions and paths are not permissible.  Wildcards are
permissible.

inputformat
is the format of the files for conversion and is one of
the following: COLORFRM, COLORFSL, 9700FRM,
9700FSL, 4075FRM, 4075FSL, UDK, XES, or ELIXIR.

outputformat
is the format of the converted files and is one of the
following: ELIXIR, COLORFRM, COLORFSL,
4050FSL, 4050FRM, 9700FRM, 9700FSL, 4075FRM,
4075FSL

pagesize
is the paper size: LETTER , LEGAL, XLARGE (11 x
17), A3, or A4.

STAND-ALONE UTILITIES
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font
specify whether to send all fonts in the font list to the
printer or just fonts used on the form: USEDFONTS or
ALLFONTS.

confirm
specify overwrite confirmation: NO to not confirm or
YES to confirm.

outputdevice
specify output to hard disk or to tape: DISK or TAPE.

palette
is the printer palette name to use for highlight color
printing.

monitor
is one of the following the monitor types (used to set
screen resolution only when converting XES files with
embedded graphics): 

-M:VGA (VGA, the default)
-M:SIGMA (Sigma L-View)
-M:WYSE (Wyse)
-M:SUPERVGA (Super VGA)
-M:NONE (None)

Directory
information Run FORMCVT from the directory in which the files to

be converted reside.  If you have not specified
drive:\ELIXIR in a DOS PATH= statement, precede
the FORMCVT command with drive:\ELIXIR.

Example To convert the A4-size Elixir form KEN.ELX in the
drive:\ELIXIR\FORMS\ELIXIR directory to FSL format
and place it in the drive:\ELIXIR\FORMS\FSLOUT
(output FSL form) directory, type:

CD \ELIXIR\FORMS\ELIXIR <Enter>

The current directory changes to the directory in which
Elixir form files reside.

FORMCVT KEN ELX FSL A4 <Enter>

This command converts the form file and writes the
output FSL file to drive: \ELIXIR\FORMS \FSLOUT.

STAND-ALONE UTILITIES
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HPEDIT

The HPEDIT utility allows editing of PCL font files.

Usage HPEDIT filename [SYMBOL=]
[POINT]  [STYLE]  [WEIGHT]  [TYPEFACE]
<Enter>

filename
is the file name or filepath of the source font. Wild
cards are allowed. 

symbol=
where symbol set 
1 = ROMAN-8, 2 = PC-8, 
3 = PC-8 (D/N), 4 = ISO.

point=
is the point size in tenths.

style=
where style 1 = UPRIGHT, 2 = ITALIC

weight
is the strokeweight between -7 and 7.

typeface
iwhere typeface is one of the following letters:

A) Presentations
B) Cooper Black
C) Courier
D) Palantino
E) Elixir
F) Black Bondini Condensed
G) Letter Gothic
H)Helvetica
I) ITC Garamond
J) Gothic
K) Micrographics
L) Line Printer
M) Swiss Condensed
N)Coronet Bold
O) Optima
P) Prestige
Q) Zaph Dingbats
R) Broadway
S) Century Schoolbook
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T) Time Roman
U) University Roman
V) Avante Garde
W) Futura
Z) Zorich Roman

Directory
information Run HPEDIT from the drive:/ELIXIR directory using

the desktop dispatcher or at the DOS prompt.

IC

The IC utility converts graphic formats.

Usage IC sourcefile [in format]
[out format]  [-options] <Enter>

sourcefile
is the file name or filepath of the source image. Wild
cards are allowed. 

in format
is the name of the source image format (Elixir, Pseg,
PCX, TIF).

out format
is the name of the target image format (Elixir, Pseg,
GOCAPSEG, PCX, TIF, Screen).

-Caaa
is the name of color or color id.
1=Blue, 2=Red, 3=Pink, 4=Green, 5=Cyan, 6=Yellow
Default:  0=Presentation process default

-Dnnn
is the output resolution in dpi (240 or 300).

-Faaa
is the record format for output options(VBM, AS400,
IRMA, OS2, MODCA)
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7-14 ELIXIR TECHNOLOGIES CORPORATION



-Wa 
is the selection for removinf white space.
N=white space not removed
Y=white space removed

-Rnnn 
is the selection to rotate pages in degrees.

-Xnnn 
is the horizontal offset in pels.

-Ynnn 
is the vertical offset in pels.

-Saaa
is the selction for monitor type (VGA, SuperVGA,
Sigma, WYSE).

Directory
information Run IC from the drive:/ELIXIR directory using the

desktop dispatcher or at the DOS prompt.

MET2871

The MET2871 utility reformats metacode files for cor-
rect processing through an 871 device that connects a
mainframe computer and printer. 

Usage MET2871 filename.ext <Enter>

filename
is the full pathname of the file for conversion.

.ext
is the file extension.

Directory
information Issue the command from the directory in which

MET2871 is located (drive:\ELIXIR). 
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METACOMP

METACOMP compresses metacode files containing
uncompressed IMG files. 

To start the METACOMP program, at the DOS prompt
type:

METACOMP [FILENAME] [COMPRESSFLAG]
<Enter>

filename
is the name of the metacode file and does not have a
file extension. 

compressflag
is either [PARTIAL] or [FULL]. [PARTIAL] is the
default.  

To display instructions for using the METACOMP util-
ity, type 

drive:\ELIXIR\METACOMP <Enter>.

drive
is the drive where Elixir is installed.

PACK

The PACK utility converts .JSL, .FSL, and other ASCII
format files to standard-labeled Xerox-format files.
PACK places a standard Xerox header on the ASCII
file, strips off text beyond column 80, and packs data
into 512-byte blocks. PACK also converts Xerox-
format files to 80-byte record length ASCII format.

Usage PACK filename.ext [convert] <Enter>

filename.ext
is the 80-byte record format file name which must in-
clude the extension. Wildcards are allowed.
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convert
BLOCK (the default) converts 80-byte record length
ASCII format files to Xerox-format files (128-byte
header followed by 512-byte blocks of data). UN-
BLOCK converts Xerox-format files from 512-byte
blocks to ASCII.

Directory
information Run PACK from the directory in which files to be con-

verted reside, using the full command, for example
C:\ELIXIR\PACK filename.ext BLOCK. If you have
specified a PATH=drive:\ELIXIR statement, you do not
need to specify drive:\ELIXIR\ in the command.

SHOWBLOK

The SHOWBLOK utility displays information about any
ElixiKeys attached to your PC and the Elixir applica-
tions you are authorized to run. 

Usage SHOWBLOK <Enter>

Directory
 information Run SHOWBLOK from the \ELIXIR directory. If you

have not specified drive:\ELIXIR in your DOS PATH=
statement, precede the SHOWBLOK command with
drive:\ELIXIR\.

Example To use SHOWBLOK to determine the ElixiKeys pre-
sent on your PC, change the current directory to drive:
then type:

CD \ELIXIR <Enter>

The current directory changes to drive:\ELIXIR.

SHOWBLOK <Enter>

If the ElixiFont and ElixiGraphics applications and
keys are installed on your PC, a message similar to
the following displays on your screen:

ELIXIFONT BLOCK PRESENT
ELIXIGRAPHICS BLOCK PRESENT
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SPUR

The Spur device connects a PC to a Xerox production
printer using bus and tag connectors. 

Online metacode files and Xerox files with 128-byte
headers are sent to a Xerox printer through the Spur
device by using the Elixir SPUR utility.

SPUR utility

The SPUR utility prepares online metacode files or
Xerox standard labeled files for transmission through
the SPUR device to a production printer. This utility in-
serts control codes in files enabling file transfer via the
Spur device.

Usage SPUR filename [header ] [sequence] <Enter>

filename
is any DOS filename including file extension. Wild-
cards are not allowed.

header
is the Xerox header format: specify PRN to send file-
name through your PC parallel port to the Spur de-
vice, or DISK to write filename to disk (in the same
directory as filename) and name it SPUR.OUT.

sequence
inserts escape sequences in the SPUR interface de-
vice output stream: USA or PPC. Specify the correct
parameter, depending on your type of SPUR device
(SPURPPC or SPURUSA).

Directory
information Run SPUR from the directory in which the input file re-

sides. If you have not specified drive:\ELIXIR in a
DOS PATH= statement, precede the SPUR command
with drive:\ELIXIR\.

Example To send the Xerox-128 byte header file XPAU10.FNT
located in the drive:\ELIXIR\FONTS\X97OUT directory
directly to the SPUR device, type:

CD \ELIXIR\FONTS\X97OUT <Enter>
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The current directory changes to
drive:\ELIXIR\FONTS\X97OUT

\ELIXIR\SPUR XPAU10.FNT PRN <Enter>

SPUR inserts control codes the SPUR device requires
to send the file directly to your printer (which should be
in HOSTCOPY mode).

Using SPUR for online metacode files 

If you are copying online metacode files to the printer,
make sure your default and ELIXIR.JSL files are
coded correctly. The printer should be online and wait-
ing to receive data before you begin the copy opera-
tion. For details on configuring your printer in an online
environment, see your production printer reference
manual.

Using SPUR for Xerox 128-byte header files

If you are copying a Xerox 128-byte header file to the
printer, make sure the printer is in HOSTCOPY mode
before you begin the copy operation. For further de-
tails on the HOSTCOPY mode, see your production
printer reference manual.
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STRIP

The STRIP utility adds a Xerox header to files. 

Usage STRIP filename [headerformat]
[KEEPNAME][-STRIP][-PAD] <Enter>

filename
is any DOS file name including the file extension.
Wildcards are permissible.

headerformat
specify the Xerox header format: NONE, 128, or 512.
NONE does not add a Xerox header.
128 adds a 128-byte Xerox header.
512 adds a 512-byte Xerox header. 

KEEPNAME
keeps the original file header name.

-STRIP
strips line numbers and trailing spaces from text files.

-PAD
pads line numbers and trailing spaces to text files.

Directory 
information Run STRIP from the directory in which the input files

reside.  If you have not specified drive:\ELIXIR in a
DOS PATH= statement, precede the STRIP com-
mand with drive:\ELIXIR.

 
Example To place 512-byte headers on all .FRM files in the

drive:\ELIXIR\FORMS\FRMOUT directory, type:

CD \ELIXIR\FORMS\FRMOUT <Enter>

The current directory changes to
drive:\ELIXIR\FORMS\FRMOUT.

\ELIXIR\STRIP *.FRM 512 <Enter>

The STRIP utility places 512-byte header records on
all files with .FRM extensions in the 
drive:\ELIXIR\FORMS\FRMOUT directory.
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TAP2DSK

The TAP2DSK utility copies files from a tape drive unit
to a PC hard disk. It also allows you to display a list of
all tape files on your screen. 

You cannot use TAP2DSK to copy Xerox metacode
files.

Usage TAP2DSK [filename ] DIR <Enter>

filename
is any DOS file name including the file extension.
Wildcards are allowed.

DIR
is used only when you want to display the tape
directory.

TAP2DSK searches the directory for files with the
specified extension. The following are the default di-
rectories TAP2DSK uses for different Xerox format
files:

Fonts (FNT) drive:\ELIXIR\FONTS\X97IN
Forms (FRM) drive:\ELIXIR\FORMS\FRMIN
Forms (Color FRM) drive:\ELIXIR\FORMS\
FRCIN
Forms (FSL) drive:\ELIXIR\FORMS\FSLIN
Forms (Color FSL) drive:\ELIXIR\FORMS\FSCIN
Logos (LGO) drive:\ELIXIR\PICS\LGOIN
Logos (Color LGO) drive:\ELIXIR\PICS\LGCIN
Images (IMG) drive:\ELIXIR\PICS\IMGIN
Images (Color IMG) drive:\ELIXIR\PICS\IMCIN

To copy 5Word format files from a tape drive unit to
your PC hard disk, you must specify the full path to
the input directory: drive:\ELIXIR\FONTS\FN6IN.

All other Xerox files (such as .TMP and .MSC) are
placed in the directory and drive from which TAP2DSK
is invoked.

Directory 
information Run TAP2DSK from the drive:\ELIXIR directory, un-

less you have specified drive:\ELIXIR in your DOS
PATH= statement.
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Example 1  For a listing of all files on a tape, type:

TAP2DSK *.* <Enter>

TAP2DSK displays a list of files on the tape.

Example 2 To copy all .FSL forms from a tape to your PC hard
disk, type:

TAP2DSK *.FSL  <Enter>

All files on the tape with .FSL extensions are copied to
the drive:\ELIXIR\FORMS\FSLIN directory.
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A.  Operational and error
 messages

This appendix lists all the operational and error mes-
sages issued by DataMerge for HP PCL/PostScript.
These messages display in message dialog boxes.
Some dialog box messages require the user to enter
a response such as [Yes], [No], or [Continue].

Messages appear in alphabetical order and are shown
in bold.  Explanations for messages are given below
the message in normal text. 

Could not open: DM.CFG
Make sure the DM.CFG file exists in the \ELIXIR di-
rectory.  If not, reinstall the software.  

Could not open: filename
File is missing or invalid.

Could not open LP3 file: filename
.LP3 file is missing or invalid.

Could not open printer font file: filename
Printer font file is missing or invalid.

ElixiKey Missing
You must have the correct ElixiKey attached to per-
form this operation.  If you connect the correct key
and you still have this error, try rearranging the order
of any keys you have attached.

Error allocating memory
Not enough DOS memory available to start operation.
Close all applications you are not working with and try
the operation again.

Error in file: filename
The .ELX file is damaged or corrupt
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Error reading file: filename
The file cannot be read.  

Merge failed
DataMerge was unable to complete the merge opera-
tion.  This may be due to a disk error.

Not enough memory
Not enough DOS memory available.  Close all appli-
cations you are not working with and try the operation
again.

Not enough memory for conversion
Not enough DOS memory available to perform the
conversion.  Close all applications you are not working
with and try the conversion again. 

Printer not ready
Make sure your printer is turned on and is online.

Printer not responding
Make sure your printer is turned on and is online.

Printer out of paper
Make sure you have paper in your printer.

OPERATIONAL AND ERROR MESSAGES
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B.  External tag attribute
 files

This appendix is available for users who need more
detailed information about the external tag attribute
file such as application developers and programmers.

The external tag attribute file contains definitions of  
data tags.  Note that the maximum number of tags al-
lowed in an external tag attribute file is 750.
        Figure B-1.  Example external tag attribute file

The sample file above shows the %%n tag markers
where n is the field number followed by a list of the at-
tributes for each field number.  (See the "Adding tags"
chapter for detailed information about applicable val-
ues for each attribute.) You can create or edit this file
using any text editor.

In your Windows application, you marked the location
of a tag by adding tag position markers (%%n).  The
external tag attribute file automatically specifies the at-
tributes associated with each tag position marker.

When you convert the .ELX document to normalized
metacode using the Elixir PrintDriver, the tag position
marker merges into your document and matches the
attributes assigned to the field number listed in the ex-
ternal tag attribute file.  If any of the data tags in the
Elixir form files have unspecified attributes, tag attrib-
utes assigned to the field number overwrite those
found in the external tag attribute file.
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C.  Command line
 parameters

The following appendix lists parameters for use when
running DataMerge in batch mode.  If no parameters
are specified, DataMerge uses the settings in
DM.CFG.  Note that these parameters override any
settings in the DM.CFG file.

Precede all parameters with -, for example:

DM [filestemname] [jobfilename] [-USENAME] [-LPT1]
[-D:value] 

The following list shows the command in bold with the
action described below.  Note that not all commands
may be applicable to your printer.

-USENAME
Uses the field name to merge the variable data.
Specify this parameter if you used format 1 to create
your .DAT file.  See the "Data files" chapter for more
information on data file formats.

-D:value
Specifies the delimiter character where value is the
delimiter character used in the .DAT file.  Specify this
parameter if you used format 3 to create your .DAT
file.  See the "Data files" chapter for more information
on data file formats. 

-O:filename
Specifies the output name where filename is the name
of the output file.

-LPT1 
Outputs file to LPT1

-LPT2 
Outputs file to LPT2
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-LPT3
Outputs file to LPT3

-DISK
Outputs file to disk

-TAPE
Outputs file to tape

-FORMDIR:directory\     
Specifies the form directory, where directory is the
.ELX forms directory to use. (Must have trailing
backslash.)

-FONTDIR:directory\ 
Specifies the screen fonts directory, where directory is
the screen fonts directory to use.  (Must have trailing
backslash.)

-TEXTDIR:directory\
Specifies the text directory, where directory is the do-
clist (.DAT file) directory to use.  (Must have trailing
backslash.)

-FONTSYES
Outputs fonts

-FONTSNO
Does not output fonts

-INTERWORD             
Uses interword justification

-INTERCHAR
Uses intercharacter justification

-DUPLEX 
Outputs in  duplex

-SIMPLEX
Outputs in simplex

-COMPRESS
Compresses graphics if possible

-NOCOMPRESS
Does not compress graphics

COMMAND LINE PARAMETERS
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-ASCII
Outputs in ASCII (for XES)

-EBCDIC
Outputs in EBCDIC (for XES)

-SMARTBOX
Outputs in EBCDIC SMARTBOX format (for XES)

-HP
Outputs to HP printer

-OFFLINE
Outputs to offline metacode printer

-ONLINE
Outputs to online metacode printer

-4235
Outputs to 4235 printer

-4700
Outputs to 4700 printer

-4045
Outputs to 4045 printer

-2700
Outputs to 2700 printer

-POSTSCRIPT
Outputs to PostScript printer

-TAGNAME:name
Specifies the external tag attribute file where name is
the external tag attribute file name

-ESCAPE:value
Specifies the escape character where value is the
decimal value of the escape character to use

-SHIFT:value              
Specifies the shift value where value is the amount to
shift forms (positive or negative)

-TRAY:value
Specifies the input tray number where value is the tray
number

COMMAND LINE PARAMETERS
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-MACRO:number       
Specifies the macro where number is the macro num-
ber to use (HP)

-PRIORITY:value     
Specifies the color priority where value is the color pri-
ority to use (XES)

-DJDE:djdestring   
Specifies the DJDE string where djdestring is the
DJDE string to use.  Include leading and trailing
spaces and use an underscore for spaces (_).

-IMAGECALLOUTS
Calls graphics resources from the printer instead of
embedding them. 

-PRINT
Prints every page (Xerox 4235 and 4700 printers)

-STORE
Stores every page (Xerox 4235 and 4700 printers)

-STOREPRINT
Stores and prints every page (Xerox 4235 and 4700
printers) 

-1
Sends graphics to the printer once.  Note that if noth-
ing is specified the default is [always]

-2
Sends graphics to the printer never.  Note that if noth-
ing is specified the default is [always]

-DOCOLOR
Specify when using color. 

COMMAND LINE PARAMETERS
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A
Acrobat Reader, docu-
mentation, 1-11
add data, 5-9

B
BPSD attributes

external tag file, B-1
BPSD tags

external tag file, B-1
Bubble Help, 1-9

C
character delimiter, 4-4
comment field, 2-6, 2-13
compressing images,
5-6
Context sensitive Help,
1-10
conventions, 1-6

display, 1-6
mouse, 1-8
typographical, 1-7

copying data fields, 2-20
copying files

to the printer, 6-10,
6-32

creating a form, 1-1
customer support, 1-3

D
D:value, 5-18
DAT files, 1-2

creating, 3-2

editing, 3-10
preparing, 3-1

data entry menu, 5-9
data field name, 4-4, 4-6
data fields, 1-2

copying, 2-20
deleting, 2-8, 2-19
editing, 2-8, 2-18
moving, 2-20
referencing, 2-9,
2-24

data files, 1-2
Data Tagging dialog
box, 2-12
datafield attributes, 2-13
DataMerge overview,
1-1
DataMerge parameters,
5-17
Dataware card, 6-31
default installation

first time, 1-23
delete after use, 2-5,
2-15
deleting data fields, 2-19
delimiter, 4-4, 4-6
Desktop

installation, 1-22
Dialog box Help, 1-10
directories

changing the de-
fault, 3-9
forms, 3-9
graphics, 3-9
images, 3-9
screen fonts, 3-9
text files, 3-9

DISP utility, 7-9
Dispatcher operations
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batch mode opera-
tion, 4-9

DJDE command string,
5-6
DM.CFG file, 5-18
documentation

accessing, 1-11
Acrobat Reader,
1-11
directory, 1-11
navigating, 1-13
printing, 1-15
scrolling, 1-14
using, 1-11
word find, 1-13
zoom in/out, 1-14

DSK2TAP utility, 7-10
duplex printing, 5-6

E
edit data, 5-11
editing a DAT file, 3-10
editing data fields, 2-18,
2-27

deleting, 2-27
ElixiDisk utility, 7-2
ELIXIR.JSL, 6-26, 6-27
Elixir applications

conventions, 1-6
Help, 1-9

Elixir PrintDriver, 2-24
ElixirViewer, 3-11

exiting, 3-16
launching, 3-11

ElixiTag, 2-25
error messages, A-1
external tag attribute file,
5-7
external tag attribute
files, 2-2, 2-21, 4-3, 4-6

creating, 2-3
modifying, 2-8
saving, 2-7

external tag file, B-1

F

Field End Character, 2-6
field gen, 2-6, 2-14
field length, 2-5, 2-14
field name, 2-5, 2-13
field number, 2-4, 2-13
File transfer, 6-1
file transfer

packages, 6-13
parameters, 6-5

files
external tag file, B-1

fonts directory, 5-4
form references

adding, 3-4
copying, 3-5

FORMCVT utility, 7-11
forms

adding data fields,
1-2
adding graphics
calls, 1-2
creating, 1-1
merging with vari-
able data, 1-2
tagging, 1-2

forms directory, 5-4
FRM files

printing, 6-26
FSL files

compiling, 6-26

G
graphics calls, 1-2, 2-21

adding, 2-21
copying, 2-23
deleting, 2-22
moving, 2-22

H
hardware requirements,
1-4
help, 1-3
Help, on-line, 1-9
Help hypergraphics,
1-11
Help menu, 1-10
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Help pop-ups and
jumps, 1-10
hostcopy mode, 6-6
HP PCL printing, 4-1
HPEDIT utility, 7-13

I
IC utility, 7-15
image compression, 5-6
info menu, 5-3
installation, 1-22

custom, 1-25
default, 1-23, 1-25
first time installation,
1-23

interface, 5-8
IRMA

FT/3270, 6-2, 6-13
FT/TSO, 6-2, 6-4,
6-14

J
job file, 3-17
job file name, 5-8
job print ticket file, 3-17

adding commands,
3-17
sample file, 3-18

justify text, 4-3, 4-6, 5-6

L
landscape, 3-15
licensing software, 1-17

M
macro number, 4-5, 5-8
main screen, 5-1
menus

data entry, 5-9
info, 5-3
print, 5-15
quit, 5-16
setup, 5-3

merge name, 4-3, 4-5
merged form

previewing, 3-11
viewing, 3-12

MET2871, 7-16
metacode files

uploading, 6-13
METACOMP utility, 7-16
modify text properties,
2-15
modifying data fields,
2-18

copying, 2-20
deleting, 2-19
editing, 2-18
moving, 2-20

mouse, 1-8
moving data fields, 2-20
moving files, 6-1

using tape, 6-29
moving offline meta-
code, 6-27
MVS host, 6-13

O
offset, 6-18
on-line documentation

accessing, 1-11
Acrobat Reader,
1-11
directory, 1-11
navigating, 1-13
printing, 1-15
scrolling, 1-14
using, 1-11
zoom in/out, 1-14

operating DataMerge
batch mode, 5-17

operational messages,
A-1
output device, 4-3, 4-8,
4-9, 5-5
output fonts, 4-4, 5-5
output format, 5-4
output name, 4-3, 4-5,
4-8, 4-9
overview, 1-1
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DATAMERGE USER GUIDE INDEX-3



P
PACK utility, 7-17
page shift, 3-15
pasting tags from Elixi-
Tag, 2-25
portrait, 3-15
PostScript printing, 4-1
prefix statement, 5-6
previewing a merged
form, 3-11
print

disk file, 3-15
print menu, 5-15
print report, 5-15
print tags, 5-15
printer, 3-14

PCL 4, 3-14
Xerox 4045, 3-14

printer commands, 3-3
printing

documentation, 1-15
HP PCL, 4-3, 4-8
offline Xerox-labeled
files, 6-25
PostScript, 4-5, 4-9
to disk, 4-6, 4-7

printing offline meta-
code, 6-27

Q
Quick Help, 1-10
quit menu, 5-16

R
referencing data fields,
2-9, 2-24
registering software,
1-17
Release notes, 1-17
replacement characters,
2-5, 2-14, 5-7
requirements

software, 1-6

S
sample application, 1-3
save setup options, 5-9
screen font directory,
3-9
search, 2-4
selecting menus, 5-2
setup menu, 5-3
setup options, 5-3
shift printer output, 4-5,
5-8
SHOWBLOK utility, 7-18
sides printed, 4-4
simplex printing, 5-6
skip, 6-18
soft keyboard, 2-18
software registration,
1-17
software requirements,
1-4
SPUR utility, 7-19
store to tag list, 2-15
STRIP utility, 7-20
support, customer, 1-3

T
tag Elixir file, 5-12
tag position marker, B-1
tagging forms, 1-2
Tagging Windows-
based docs, 2-24

deleting tags, 2-27
editing tags, 2-27

tags directory, 2-15
TAP2DSK utility, 7-21
Tape drive configuration,
1-5
text directory, 5-4
training, 1-4
tray number, 4-4, 5-8

U
UDK escape code, 5-7
usename, 5-18
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using existing tags, 2-15
utilities

DISP, 7-9
DSK2TAP, 7-10
ElixiDisk, 7-2
FORMCVT, 7-11
HPEDIT, 7-13
IC, 7-15
MET2871, 7-16
METACOMP, 7-16
PACK, 7-17
SHOWBLOK, 7-18
SPUR, 7-19
STRIP, 7-20
TAP2DSK, 7-21
using, 7-1
XCPY, 7-5
XDEL, 7-8
XDIR, 7-3
XFORMAT, 7-4

V
variable data

adding, 3-5
format 1, 3-6
format 2, 3-7
format 3, 3-8

variable data files, 3-1
creating, 1-2, 3-2
editing, 3-10
preparing, 3-1

viewing tags, 2-17

W
word find, 1-13
write tag file, 5-13

X
XCPY utility, 7-5
XDEL, 7-8
XDIR utility, 7-3
Xerox-labeled files, 6-1

printing, 6-25

uploading, 6-2, 6-4
XFORMAT utility, 7-4
XWIN.log

installation, 1-22

Z
zoom in/out, 1-14
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